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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



Rev. 7: 12-03-2024

The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorised personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des controleurs de type ouvert. Il est
nécessaire d'installer 'automate M-Duino dans un boftier, une armoire ou une salle de
contréle électrique. L'acces au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmospheére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e QOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.

IS
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct manner. It
must respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS's test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
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trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED
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Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:

UL Std. 61010-1
qb UL Std. 61010-2-201
c us Cert. To CSA Std. C22.2 No. 61010-1
e Cert. ToCSA Std. C22.2 N0.61010-2-201
Intertek
Place for control

number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and D the shield from above. Having a B and a C in the middle of them.

i EE0d
[T
W wwy
i = £ 5 Z
8608 ‘ 8855
<m0 T 'D ZONR O @ <
e 'C ZONE
wesn o | B ZONE
{ mi@.y 'AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

e Theinputsin the zone C are named 11.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X

10
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1.2 Reference table

Reference Table
Model Reference
PLC M-Duino General Family
M-Duino PLC Arduino Ethernet 19R I/Os Analog / Digital Plus IS.MDUINO.19R+
M-Duino PLC Arduino Ethernet 21 1/Os Analog / Digital Plus IS.MDUINO.21+
M-Duino PLC Arduino Ethernet 38AR I/Os Analog / Digital Plus IS.MDUINO.38AR+
M-Duino PLC Arduino Ethernet 38R |/Os Analog / Digital Plus IS.MDUINO.38R+
M-Duino PLC Arduino Ethernet 42 I/Os Analog / Digital Plus IS.MDUINO.42+
M-Duino PLC Arduino Ethernet 50RRA I/Os Analog / Digital Plus IS.MDUINO.50RRA+
M-Duino PLC Arduino Ethernet 53ARR 1/Os Analog / Digital Plus IS.MDUINO.53ARR+
M-Duino PLC Arduino Ethernet 54ARA 1/Os Analog / Digital Plus IS.MDUINO.54ARA+
M-Duino PLC Arduino Ethernet 57AAR I/Os Analog / Digital Plus IS.MDUINO.57AAR+
M-Duino PLC Arduino Ethernet 57R 1/0Os Analog / Digital Plus IS.MDUINO.57R+
M-Duino PLC Arduino Ethernet 58 I/Os Analog / Digital Plus IS.MDUINO.58+

To find the reference of your M-Duino PLC, check the arrow in the picture below. In the
example, the reference is: IS.MDUINO.58+

11
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1.3 Zones Table

Zones Table
Model Zone A Zone B Zone C Zone D

M-Duino PLC 19R+ v Relay - -

M-Duino PLC 21+ v Analog / Digital - -
M-Duino PLC 38AR+ v Analog / Digital Relay -

M-Duino PLC 38R+ v Relay Relay -

M-Duino PLC 42+ v Analog / Digital | Analog / Digital -
M-Duino PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino PLC 57AAR+ v Analog / Digital | Analog / Digital Relay

M-Duino PLC 57R+ v Relay Relay Relay

M-Duino PLC 58+ v Analog / Digital | Analog / Digital | Analog / Digital

The distribution of the different features that provide the M-Duino PLC Family is the following

one:
Shield B Zone C Zone D Zone
13 Inputs 13 Inputs 10 Inputs
(13 Digital Inputs, 6 (13 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
8 Outputs 8 Outputs 6 Outputs
(8 Digital Outputs, 3 | (8 Digital Outputs, 3 | (6 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
6 inputs 6 inputs 6 inputs
(6 Digital Inputs, 4 of | (6 Digital Inputs, 4 of | (6 Digital Inputs, 4 of
Relay Shield which can work as which can work as which can work as
Analog Input) Analog Input) Analog Input)
3 Outputs 3 Outputs 2 Outputs
(3 Digital Outputs, 3 | (3 Digital Outputs, 3 | (2 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Output)
8 Relays 8 Relays 7 Relays

12
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Shield

A Zone

Communication

Shield

(1x) Ethernet
(1x) USB

(1x) 12C

(2x) TTL

(1x) RS-232

(1x) SPI external Port
(1x) RTC
(1x) uSD Socket

(1x) HALF/FULL Duplex RS-485

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) | Depth (mm) | Max weight (g)
M-Duino PLC 19R+ 119.5 70.1 101 378
M-Duino PLC 21+ 119.5 70.1 101 378

M-Duino PLC 38AR+ 119.5 94.7 101 438
M-Duino PLC 38R+ 119.5 94.7 101 488
M-Duino PLC 42+ 119.5 94.7 101 488

M-Duino PLC 50RRA+ 119.5 119.3 101 598

M-Duino PLC 53ARR+ 119.5 119.3 101 598

M-Duino PLC 54ARA+ 119.5 119.3 101 598

M-Duino PLC 57AAR+ 119.5 119.3 101 598
M-Duino PLC 57R+ 119.5 119.3 101 598
M-Duino PLC 58+ 119.5 119.3 101 598

13
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1.6 General Features
CONNECTABLE PLC ARDUINO 24Vcc M-DUINO
MODEL TYPE Controller General Specifications Information
12 to 24Vde Fuse pr'otectlon (?.SA)
Input Voltage Polarity protection
24vdc
Input rated voltage —
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
. . 12C — Ethernet Port — USB — RS485 — RS232 — SPI —
Communications SerialTTL (x2) Max232-Max485-W5500
. . Only meant for uploading or debugging, not always Cannot be working in a final
]
USB consideration! connected as a serial in a project! application
0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10vdc Max read time: 116 us
An/Dlg Inlet 10bit 5 to 24Vdc *Check Section 13 for digital
(0-10Vce) I min: 2 to 12 mA inputs threshold detection
Galvanic Isolation
Rated Voltage: 24Vdc
5 to 24Vdc
I min: 2 to 12 mA All Digital Inputs are PNP .
Digital Isolated Input Galvanic Isolation Click here' for more information.
(24Vcc) Rated Voltage: 24Vdc
== Max read time: 8 us
5 to 24Vdc
% | d I'min: 2 to 12 mA
Interrupt isolated Input i [
P P Galvanic Isolation Max read time: 8 us
HS (24Vce) Rated Voltage: 24Vdc
0 to 10Vdc
| max: 20 mA Output frequency: 2Hz
Analog Output 8bit Separated PCB ground
(0-10Vcc) Rated Voltage: 10Vdc Rising edge time: 150 ms
Falling edge time: 252 ms
5 to 24Vdc Imax 24Vdc: 410 mA
Gall\r/T;?\)i(; Ts?)ggon LU
Digital Isolated Output : freq is 6.849 kHz
Diode Protected for Relay with pulse width of 106 us
(24Vce) Rated Voltage: 24Vdc P
To= Rising edge time: 476 ns
Falling edge time: 42.8 us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193

14
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vvdc
I max: 40 mA
Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200 ns
Falling edge time: 200 ns

Direct Arduino Pin iz Ltz ,
I max: 40 mA Max read time: 8 us
InpUt Rated Voltage: 5Vdc
12C Pin Max frequency: 100 kHz

5V Internal Pull-up

Rising edge time: 10 us
Falling edge time: 150 ns

One-Wire Pin

Usable pins:
Pin 2, Pin3, SCL, SDA, RX0, TXO,
RX1, TX1, MISO, MOSI, SCK

Frequency: 800 kHz

Expandability

12C-127 elements - Serial Port RS232/RS485

* By using this type of signal it can no longer be used as Digital signal
(24vdc)

15
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1.7 Power consumption of the M-Duino Family PLCs

Model Current resting | Power resting Current active Power active
(mA) (W) (mA) (W)
21+ 99 2,376 120 2,88
42+ 92 2,208 128 3,072
58+ 76 1,824 126 3,024
19R+ 80 1,92 202 4,848
38R+ 77 1,848 313 7,512
57R+ 73 1,752 425 10,2
38AR+ 72 1,728 221 5,304
53ARR+ 71 1,704 323 7,752
57AAR+ 71 1,704 221 5,304
54ARA+ 76 1,824 231 5,544
50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs.”

16
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Technical Specifications:

em M-Duino Family PLC
Power supply
voltage DC power supply 12 to 24Vdc
Operating
voltage range DC power supply 11.4 to 25.4Vdc —_
Power
consumption DC power supply 30W max.
Power supply 2avde —
External power voltage
SEJpp|y Power supply
requirements minimum output 700mA

capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external
AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

02 to 602C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-202 to 602C

Power supply holding time

2ms min.

Weight

Check size and weight table

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz

17



http://arduino.cc/en/Tutorial/HomePage

2.3 Symbology

Rev. 7: 12-03-2024

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Family:

Standard No. /

Syl Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC/
Electromagnetic
Compatibility

N
m

ISO 7000/ Graphical
symbols for use on
equipment

ISO 7000/ Graphical
symbols for use on
equipment

~ [>

Standard Reference
No. / Symbol Title

5031 / Direct
Current

5032 / Alternating
Current

5130 / Pulse General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

04348/
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only; to
identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which a
pulse is started.

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is
explicitly required.

To identify the switch by means
of which the signal lamp(s) is
(are) switched on or off.

CE marking indicates that a
product complies with applicable
European Union regulations

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

To indicate hazards arising from
dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino Family PLCs include an Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, who must have knowledge on electrical systems.
3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in
this manual. Before using M-Duino under different conditions from what has been specified in
this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of M-Duino are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
double safety mechanisms. This manual provides information for programming and operating
the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

19
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4 M-Duino Pinout
10s Table
Analog Digital Isolated Digital Isolated Digital/Analog Relay PWM Isolated
Model Reference
Input*’ Input Output Output Output Output*?
19R+ IS.MDUINO.19R+ 4 2 0 3 8 3
21+ IS.MDUINO.21+ 6 7 5 3 0 3
38AR+ IS.MDUINO.38AR+ 10 9 5 6 8 6
38R+ IS.MDUINO.38R+ 8 4 0 6 16 6
42+ IS.MDUINO.42+ 12 14 10 6 0 6
50RRA+ IS.MDUINO.50RRA+ 12 10 4 8 16 8
53ARR+ IS.MDUINO.53ARR+ 14 11 5 8 15 8
54ARA+ IS.MDUINO.54ARA+ 14 15 9 8 8 8
57AAR+ IS.MDUINO.57AAR+ 16 16 10 8 7 8
57R+ IS.MDUINO.57R+ 12 6 0 8 23 8
58+ IS.MDUINO.58+ 16 20 14 8 0 8

*1 The analog inputs can also be used as digital inputs.
*2The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM
and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base
A Zone
M-Duino Arduino Function
Connector Pin
AREF AREF Arduino Pin
sQw SQW Arduino Pin
3.3Vdc 3.3Vdc Arduino Pin
5Vdc 5Vdc -
GND GND GND
Base
A Zone
M-Duino Arduino Function
Connector Pin
SCL 21 12C/SS
SDA 20 12C/SS
RX0 0 RX0/SS
TXO0 1 TX0/SS
RX1 19 RX1/SS
TX1 18 TX1/SS
X 16 RS232
RX 17 RS232
Z- - RS485
Y+ = RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51l 51 SPI
52 SCK 52 SPI
Reset Reset SPI
5Vdc 5Vdc 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd (Power Supply)
Vdc Vdc (Power Supply)

Rev. 7: 12-03-2024

Configuration Swilch® {ses section & for configuring the
communications.

Enabling communications desables soma 110s)

Communication Fing

Power supply connecions

{12124vde - GHND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.
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Ethérnet set USB-B

C Programm@able button
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5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
1X.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)1X.6 GND IX.6
IX.6/INT? Interrupt X In
(-)IX.5 GND IX.5
IX.5/INT! Interrupt X In
(-)ix.4 GND IX.4*
IX.4 Digital Input*
(-)1x.3 GND IX.3
IX.3 Digital Input
(-)IX.2 GND IX.2
IX.2 Digital Input
(-)Ix.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors 1X.12, 1X.11 and IX.4 are not connected (NC) in D Zone.

Top Zone

%
X
%3
Kl
xll
®
X
X
%l

Led indicator 1/Os state

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out
Qvdc External Isolated Out Vdc
COM(-) External Isolated Out GND
QXx.7 Digital/PWM Out*
Qx.6 Digital/PWM Out
QX.5 Digital/PWM Out
Qx.4 Digital Qut*
Qx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.o0 Digital Out

B S

DCAAHT 4
W AT a-]

* Maole: wse comectly monfgueation for

us this signal
[l LR gl

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.
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Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*

(sea section 8 fo select the corract
configuration for autputs),

Anakog Cutputs
Veltage Supply'Reference for

Digital PWh Qutputs (isolated)

Digital Cutputs
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5.3 Relay Zone connection (I/0s)

X Zone ]
M-Duino Function
Connector
RX.8 Relay Out
RX.Z Relay 8ut
RX. Relay Out Relay Output
RX.5 Relay Out* R
RX.4 Relay Out
AX.2 Analog Out*
AX.1 Analog Out
AX.0 Analog Out
GND GND
Qx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out
QXx.0 Digital/PWM Out _
COM(-) External Isolated Out Gnd Analog Qutputs (Switch
QVvdc External Isolated Out Vdc Canfiguration)
*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.
Digital/PWh Qutputs {isolated)
Top Zone _
oo N e T L U B R T N = -:
X X X X X X />< xX X

Led indicator 1/Os state

X Zone
M-Duino Connector Function
RX.3 Relay Out Relay Outputs
RX.2 Relay Out
RX.1 Relay Out 1‘1:1’{.;
GND GND aivae
IX.5 Analog/Digital Input Digitat
IX.4 Analog/Digital Input - e
IX.3 Analog/Digital Input B
IX.2 Analog/Digital Input & - 24
IX.1/INT? Interrupt X In — anD
(-)Ix.1 GND IX.1 . 155 Analog/Digital Inputs
IX.0/INT Interrupt X In E e
(-)IX.0 GND IX.0 g s
jq I-iTn— [FR] )
= = -1 Interrupt Inputs (isolated)
o o
i“ — (10
EE é Ja|we
E 2. EH Configuration Swileh*
21 B
i § g4 Ealceg (200 saction B 1o select the corroct

configuration for cutputs).

3 See section 5.4 to know more about interrupt pins.

24



Rev. 7: 12-03-2024

5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay
PLC
Zone PLC Input Interrupt M-Duino Pin PLC Input | PLC Interrupt M-Duino Pin
0.6 INT1 PIN3 0.1 INT1 PIN3
° 0.5 INTO PIN2 0.0 INTO PIN2
1.5 INT5 PIN19 1.1 INTS PIN19
¢ 1.6 INT4 PIN18 1.0 INT4 PIN18
25 INT3 PIN21 21 INT3 PIN21
> 2.6 INT2 PIN20 2.0 INT2 PIN20

Check this link for more information.
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Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino
Editor language:
Editor font size:
Interface scale:
Theme:
Show verbose output during:

Compiler warnings:

Display line numbers
Verify code after upload

Check for updates on startup

Use accessibility features

Additional Boards Manager URLs:

More preferences can be edited directly in the file

/home/annal.arduinolS/preferences.txt

(edit only when Arduing is not running)

2.

Browse

English (English) v (requires restart of Arduino)
12
Automatic % (requires restart of Arduino)
Default theme v (requires restart of Arduino)
compilation upload
None v

Enable Code Folding

Use external editor

Save when verifying or uploading
fapps.industrialshields.com/main/arduina/boards/package_industrialshields_indexjson
OK  Cancel

In Additional Boards Manager URLs write the following:



http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

Rev. 7: 12-03-2024

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch

Help
Auto Format Ctri+T
Archive Sketch

sketch jul21a
woid setup() | Fix Encoding & Reload

7/ put your Manage Libraries... Ctrl+Shift+

L Serial Monitor Ctrl+Shift+M

'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDECX DALI farmily, ARDEOX GPRS family, ARDEOX LoRa family, ARDEOX WiFi/BT family, M-Duinc family, M-Duingo DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch Help

Auto Format

K Archive Sketch
sketch_jul21a

void setup()
£ put your

L Serial Monitor

void leop() { serial Plotter
£ put your

Fix Encoding & Reload

Manage Libraries...

ctrl+T

Ctrl+Shift+I

Ctrl+Shift+M

} WIFi101 / WiFININA Firmware Updater

B Duino family Boards Manager...

Model: "M-Duino 58+"

Port: "/dev/ttyACMO (Arduino Mega or Mega 2560)"

Get Board Info

Png rammer

Burn Bootloader

Ctri+Shift+L

Z Arduino AVR Boards >
Ardbox family
Ardbox DAL family
> Ardbox GPRS family

Ardbox WiFI/BT family

‘Ardbox LoRa Ta

© M-Duine family

M-Duine GPRS family

M-Duino LoRa family

M-Duine WiFI/ET family

M-Duine WiFi/BT + GPRS family

Once it is selected M-Duino Family,

File Edit Sketch

sketch_jul21a
void setup()
/7 put your

¥

Help
Auto Format

Archive sketch

Fix Encoding & Reload
Manage Libraries

Serial Monitor

void loop() { serial Plotter

71 put your

WiFi101 / WiFININA Firmware Updater

Board: "M-Duino fami

Model: "M-Duino 58+

Port: "devittyACMO (Arduino Mega or Mega 2560)"

Get Board Info

Programmer

Burn Bootloader

an extra option will appear on Tools:

CrlT

Ctrl+Shift+
Ctrl+Shiftei

Ctrl+shifeL

> M-Duine 19R
' > M-DuinG 19R+
M-Duine 21
M-Duino 21+
M-Duino 38AR+
M-Duino 38R
M-Duino 38R+
M-Duino 42
M-Duino 42+
M-Duino 50RRA+
M-Duino 53ARR+
M-DUinG S4ARA+
M-DuinG STAAR+
M-Duine 57R
M-DuinG 57R+

M-Duine 58

There, it can be selected the exact model for every family.
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Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields

7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

Open Arduino IDE interface:

Select Industrial Shields boards -> M-Duino Family

Select the correct M-Duino Board (M-Duino 58+ in our example).

File Edit Sketch Help
Auto Format CreT
Archive Sketch
sketch jul21a

w0id setup() | FixEncading & Reload

P YU anage Libraries Ctrl+Shift+]
} Serial Monitor curl+shiftsia
woid loop() { Serial Plotter Ctri+shiftrL
74 put your
3 WIFIT01 £ WIRININA Firmware Updater
Board: "M-Duino family” >
Port;*/dev/ttyACMO (Arduine Mega or Mega 2560)" > | M-Duino 19R+
Get Board Info M-Duino 21

M-DUino 21+
Programmer

M-DUinG 38AR+
Burn Bootloader

M-Duing 38R

M-Duine 38R+

M-Duine 42

M-Duing 42+

M-Duing S0RRA+

M-Duing 53ARR+

M-Duino 54ARA+

M-Duino 57TAAR+

M-Duino 57R+

-DUino 58
© M-Duino 58+ —
M-Duino family, M-Duino 58+ on /dev/ttyACMO

- Select the correct port.

File Edit Sketch Help
Auto Format CorleT
Archive Sketch
sketch_jul21al

void setup() | FixEncoding & Reload
71 put your

Manage Libraries... Ctrl+Shift+]
} Serial Monitor Ctrl+shiftrM
void loop() { Serial Plotter CtrhShift+L
71 put your
} WIFI101 / WIFININA Firmware Updater
Board: "-Duino family” >
Model: "M-Duino 58+" >

Port: "/dev/ttyACMO (Arduino Mega or Mega 2560)" >
Get Board Info fdevittyACMO (Arduino Mega or Mega 2560)

Programmer >

Burn Beotloader
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8 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

B | ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- GND n-_l—ll "3“13'24 e }

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:
-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

e
oo
By
.
L]
L]
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.

iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
RX1 | XX RX1 XX
TX1 | XX TX1 XX
Pin 3 | XX Pin 3 XX
Pin 2 | XX Pin 2 XX
SD | XX SD XX
FD | HD FD HD

= L This is an A Zone Switch example from M-Duino 19R+. In this
Zenille case, SCL, SDA, RX1, TX1, 10.1, Pin 2, SD and HD are enabled. This
SDA/NC . .
RX1/ NC means Pin 3, 10.0 and FD are disabled. (NC refers to Not
TX1/NC Connected).
Pin3/10.1
Pin2/10.0

sSD
FD RS485 HD
OFF ON

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

2. RX1 | XX: Choosing between RX1 or the input XX. If the switch is ON, it enables XX and
disables RX1. If the switch is OFF, it enables RX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

1. TX1 | XX: Choosing between TX1 or the input XX. If the switch is ON, it enables XX and
disables TX1. If the switch is OFF, it enables TX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and
disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone OFF ON
Switch OFF ON NC NC
NC : : NC  NC
NC - - Q RTC
NC | RTC - RTC “RTC
NC | RTC - RTC

This switch enables the communication with RTC using 12C. Having this switch in ON mode
activates the communication, whereas if it is in OFF mode it disables the 12C to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - ]
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 Qx.6
AX.5 | QX.5 AX.5 Qx.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
Al7 Q1.7
Ale Ql.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qx.2
AX.1]| QX.1 AX.1 ax.1
AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF OnN We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0l Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V,
which are explained in the following sections.

10.1 I12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

In order to use them as an internal arduino direct PIN at 5V, it has to be considered that they
are pull-up inputs (a 2200Q) resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.3 Serial 1 - RX1/TX1

To know how to configure these pins correctly, check section 9. If not using the Serial 1
interface these pins can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.4 SPI - MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time, as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.5Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.
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11 A Zone Features: Communications § RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here* or here® to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14

RO 15

RE 11

DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here® or here’ to see more about this communication.

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183

4
> https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16
6
7

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C, as it can already be used
with the standard library of Arduino, called Wire.

Click here® to see more about this communication.
11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here® to see more about this communication.

11.5TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).

Click here®® and here'! to see more about this communication.

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
S https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
10 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

Click here® to see more about this feature.
11.8uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch isin ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here® to see more about this feature.

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.
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12 Instructions for interconnection between Industrial

Shields controllers

12.1 RS-232 Communication:

~M-Duino Family - Another Industrial
PLC Shlelds PLC
I{_Hl-l:.-ﬂ- Faseribis (4 |-u'".|.l:|\
Tx e Tl A T
RS-232 g, NN N gy Re22
Frearita KITA Farrite KITA

GND “\_/"X_)@ GND
1224y = W 12028

12.2 RS-485 Communication:

12.2.1 Half Duplex

. M-Duino Family'r._"" " Another Industrial
| PLC | | Shields PLC |

HHECG Ferte (4 Loops)
RS-485 ‘;‘ @ E‘;::};:}?ﬂ:;‘ RS-485
SHIELDED CABLE
Ferrile KITA Farrite KITA
_ Ly - GND

GND - 1 -
oy XA XY OO amn

o - “ ¢

12.2.2 Full Duplex

* M-Duino Family - Another Industrial
| PLC [ Shlelds PLC

FIE G | arntes (8 Loops)
RS.85 O AL E B Rzass

[eite KITA o el Ferite ©ITA
T _ SHIELDED {

. GHO
sanay XA FH OO
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12.3 Ethernet

KRFC-6 Ferrhe
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5B

M-Duino Family -

PLC

Fearile KITA

GHD -~ — — — }
1224 R ./\.__\-/\_ _@

Etharnat

: Anaother Industrial
Shields PLC

Femtie KITA

o ., o~ GND

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

13 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 4
Analog input 5.1
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14 I/0 technical details:

A comparison between the waveforms of the 1/Os from the M-Duino PLC and the Arduino
Mega is done in this section.

Digital Output Waveform:

[ T Ll o ——
v

DIGITAL OUT

>

DIGITAL OUT
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

ARDUINODUT
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15 Typical Connections

GND N @00
SH2124V o o j} 0.0
SHIELDED CABLE

Ferrite KITA

S Rl S

SHIELDED CABLE / Dowrsoad B MDUING LAYOUT:

B

Ferrite KITA

[
g] 0 POWER
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SHIELDED CABLE ,J Douniod oo MOURO LAYOUT:
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SHIELDED CABLE
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Ferrite KITA
5

i —

SHIELDED CABLE
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) | Power
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7 From: wew industialshieids com Y
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S
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46



010V
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SHIELDED CABLE

ALWAYS
CONNECTED
&
VOUT = Q/Vdc

SHIELDED CABLEf o wone tradata o \_
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VOUT = Q/Vde

SHIELDED CABLE

DIGITAL / PAWM |SOLATED
OUTPUT
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A
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16 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529 connector
from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x0.8 mm
Pin spacing 2.5mm
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 1803426 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC is the
male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8x0.8 mm

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm
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17 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15

Top hot rail TH 35-15

154
155
-———] =004
15°
ROS
R12
RO8
o~
H
= —ed 1004
Sezione A / Section A R12
o~ 2,2 min. finoa / To 2,5 max
S| —e
1l
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisozn o JSTMDB38  MPo 68 Mechanical test Resistonce o torsil stess of yield ASTMDE3E P 68
Resishiwn o tazione o mttwo JTMDB3E  MPo 48 Tenslostength ASTMDE3E  WPa 48
Alongomento a rotvn JTMDB3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flaing modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 15016014 X/m'* 55
Termiche Temp di mmmolimento Vit mewdo B ASTM DISZS  °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 14
Tomperatu Ricot 1 B1 MRy KTHDe48  °C 7 Rebeating omperature 1.81 WPo ASTMDE4E  °C 7
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mould shrinkge ASTIDISE % 0405
Mk Flow Index 260°C - 98N KIMDIZ3E g0 111 Mkt Fow Indax 260°C - 98 ASTMDIZ38 g0’ 1.1
Comportamento Aubestinguerea (mm di spesor) s V-0(08) Flame test Self atinguisher (fhidkness in mm) [I[E2) V-0(08)
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondssien thiead 32 mm IECE9521  °C 90

Ialtronic si riserva il diitto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the moteriols without being obliged 1o forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with 1K08
mechanical protection. The minimum IP protection degree required is IP56.
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18 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25cm
above and below the devices. Also, allow at least 25cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
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- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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19 Revision Table

Revision Number Date Changes
0 30/08/2019 First implementation
1 21/02/2020 ETL Listing Mark-Direct
2 12/01/2022 Updated CE Normative (2004/108/EC)
3 25/07/2022 M-Duino Family User Manual Implementation
4 11/03/2024 Added section 13 “Digital inputs threshold detection”
5 06/05/2024 Serigraphy update on Section 5.1
6 26/09/2024 Added section 3.4 (“Isolation Precautions”)
7 12/03/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
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Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.
Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

o Improper use of this product may severely damage the controller.
Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

® Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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The M-Duino WIFi/BLE Family PLCs are Open Type Controllers. It is required that you
install the M-Duino WiFi/BLE PLC in a housing, cabinet, or electric control room. Entry
to the housing, cabinet, or electric control room should be limited to authorised
personnel. Failure to follow these installation requirements could result in severe
personal injury and/or property damage. Always follow these requirements when
installing M-Duino family PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des contrbéleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de Ia
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphéere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

o Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e QOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.

IS
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It must
respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS's test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:

UL Std. 61010-1
qb UL Std. 61010-2-201

c us Cert. To CSA Std. C22.2 No. 61010-1

e Cert. ToCSA Std. C22.2 No.61010-2-201

Intertek

Place for control

number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO WiFi/BLE product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and D the shield from above. Having a B and a C in the middle of them.:

HE EEE]
il i
gy Wwww
FZEEE ZEEZ
QRRR . RERQ
Lmo0O e D ZONR O @ <L
) ' C Z0NE
wwse B ZONE
(- r=miroi A ZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X

10
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Reference Table

Model Reference

PLC M-Duino General Family
M-Duino PLC Arduino Ethernet & WiFi & BLE 19R I/Os Analog / Digital Plus 007001000100
M-Duino PLC Arduino Ethernet & WiFi & BLE 21 1/Os Analog / Digital Plus 007001000200
M-Duino PLC Arduino Ethernet & WiFi & BLE 38AR I/Os Analog / Digital Plus 007001000700
M-Duino PLC Arduino Ethernet & WiFi & BLE 38R I/Os Analog / Digital Plus 007001000300
M-Duino PLC Arduino Ethernet & WiFi & BLE 42 1/Os Analog / Digital Plus 007001000400
M-Duino PLC Arduino Ethernet & WiFi & BLE 50RRA 1/Os Analog / Digital Plus 007001000900
M-Duino PLC Arduino Ethernet & WiFi & BLE 53ARR 1/Os Analog / Digital Plus 007001001000
M-Duino PLC Arduino Ethernet & WiFi & BLE 54ARA |/Os Analog / Digital Plus 007001001100
M-Duino PLC Arduino Ethernet & WiFi & BLE 57AAR 1/Os Analog / Digital Plus 007001000800
M-Duino PLC Arduino Ethernet & WiFi & BLE 57R I/Os Analog / Digital Plus 007001000500
M-Duino PLC Arduino Ethernet & WiFi & BLE 58 I/Os Analog / Digital Plus 007001000600

To find the reference of your M-Duino WiFi/BLE PLC, check the arrow in the picture below. In

the example, the reference is:

11
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Zones Table
Model Zone A Zone B Zone C Zone D

M-Duino WiFi/BLE PLC 19R+ v Relay - -

M-Duino WiFi/BLE PLC 21+ v Analog / Digital - -
M-Duino WiFi/BLE PLC 38AR+ v Analog / Digital Relay -

M-Duino WiFi/BLE PLC 38R+ v Relay Relay -

M-Duino WiFi/BLE PLC 42+ v Analog / Digital | Analog / Digital -
M-Duino WiFi/BLE PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino WiFi/BLE PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino WiFi/BLE PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino WiFi/BLE PLC 57AAR+ v Analog / Digital | Analog / Digital Relay

M-Duino WiFi/BLE PLC 57R+ v Relay Relay Relay

M-Duino WiFi/BLE PLC 58+ v Analog / Digital | Analog / Digital | Analog / Digital

The distribution of the different features that provide the M-Duino WiFi/BLE PLC Family is the

following one:

Shield B Zone C Zone D Zone
13 Inputs 11 Inputs 10 Inputs
(13 Digital Inputs, 6 (11 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
8 Outputs 8 Outputs 6 Outputs
(8 Digital Outputs, 3 | (8 Digital Outputs, 3 | (6 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
6 inputs 4 inputs 6 inputs
(6 Digital Inputs, 4 of | (4 Digital Inputs, 4 of | (6 Digital Inputs, 4 of
which can work as which can work as which can work as
Analog Input) Analog Input) Analog Input)
Relay Shield
3 Outputs 3 Outputs 2 Outputs
(3 Digital Outputs, 3 | (3 Digital Outputs, 3 | (2 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Output)
8 Relays 8 Relays 7 Relays

12
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Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) WiFi/BLE

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) | Depth (mm) | Max weight (g)
M-Duino WiFi/BLE PLC 19R+ 119.5 70.1 101 394
M-Duino WiFi/BLE PLC 21+ 119.5 70.1 101 394
M-Duino WiFi/BLE PLC 38AR+ 119.5 94.7 101 504
M-Duino WiFi/BLE PLC 38R+ 119.5 94.7 101 504
M-Duino WiFi/BLE PLC 42+ 119.5 94.7 101 504
M-Duino WiFi/BLE PLC 50RRA+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 53ARR+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 54ARA+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 57AAR+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 57R+ 119.5 119.3 101 614
M-Duino WiFi/BLE PLC 58+ 119.5 119.3 101 614

13
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CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

USB consideration!

MODEL TYPE Controller General Specifications Information
input Votage i s
Input rated voltage Zic
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
Communications I12C — Ethernet Port — USI? - RS-485 - R?Z?Z —SPI - Max232-Max485-W5500 -
(1x) RX, TX (Arduino pins) — Wi-Fi ESP32
Only meant for uploading or debugging, not Cannot be working in a final
application

always connected as a serial in a project!

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

All Digital Inputs are PNP.

Click here? for more
information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc

| max: 20mA
Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
(24Vcce)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70 us delay,
freq is 6.849MHz
with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM lIsolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA
Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin Vi il ,
| max: 40mA Max read time: 8us
Input Rated Voltage: 5Vdc
12C Pin Max frequency: 100kHz
5V Pull-up Rising edge time: 10us
Falling edge time: 150ns
Usable pins:
One-Wire Pin Pin 2, Pin3, SCL, SDA, RX0, TXO, Frequency: 800kHz

MISO, MOSI, SCK

Expandability

12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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1.7 Power consumption of the M-Duino WiFi/BLE Family PLCs

Model Current resting | Power resting Current active Power active
(mA) (W) (mA) (W)

21+ 99 2,376 120 2,88
42+ 92 2,208 128 3,072
58+ 76 1,824 126 3,024
19R+ 80 1,92 202 4,848
38R+ 77 1,848 313 7,512
57R+ 73 1,752 425 10,2
38AR+ 72 1,728 221 5,304
53ARR+ 71 1,704 323 7,752
57AAR+ 71 1,704 221 5,304
54ARA+ 76 1,824 231 5,544
50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs.”

16
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2.1 General Specifications
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Item M-Duino WiFi/BLE Family PLC

Power supply

voltage DC power supply | 12 to 24Vdc

Operating
voltage range | DCPOWersupply | 11.4to25.4vdc
Power
consumption DC power supply | 30W max.
Power supply Javde ===

External voltage

power supply Power supply - 00mA

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective ground terminal.

Shock resistance

80m/s?in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

09 to 602C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -209 to 60°C
Power supply holding time 2ms min.
Weight Check size and weight table

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of

a programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz

17
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Table that includes all the symbology that is used in the serigraph of the M-Duino WiFi/BLE PLC

Family:

Standard No. /

Sibe Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/ Graphical
symbols for use on
equipment

ISO 7000/ Graphical
symbols for use on
equipment

I1
L
X
€
A
(

Standard Reference
No. / Symbol Title

5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only; to
identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which a
pulse is started.

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is
explicitly required.

To identify the switch by means
of which the signal lamp(s) is
(are) switched on or off.

CE marking indicates that a
product complies with applicable
European Union regulations

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

To indicate hazards arising from
dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino GPRS PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino GPRS Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in
this manual. Before using M-Duino under different conditions from what has been specified in
this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of M-Duino are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
double safety mechanisms. This manual provides information for programming and operating
the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.
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4 M-Duino Pinout
10s Table
Analog Digital Isolated Digital Isolated Digital/Analog PWM Isolated

Model Reference Input*’ Input Output Output Relay Output Output*?

19R+ 007001000100 4 2 0 3 8 3

21+ 007001000200 6 7 5 3 0 3
38AR+ 007001000700 10 7 5 6 8 6

38R+ 007001000300 8 2 0 6 16 6

42+ 007001000400 12 12 10 6 0 6
50RRA+ 007001000900 12 4 8 16 8
53ARR+ 007001001000 14 5 8 15 8
54ARA+ 007001001100 14 13 9 8 8 8
57AAR+ 007001000800 16 14 10 8 7 8

57R+ 007001000500 12 4 0 8 23 8

58+ 007001000600 16 18 14 8 0 8

*1The analog inputs can also be used as digital inputs.
*2The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM
and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base
A Zone
M-Duino Arduino Function
Connector Pin
AREF AREF Arduino Pin
sQw SQW Arduino Pin
3.3Vdc 3.3Vdc -
5Vdc 5Vdc GND
GND GND
Base
A Zone
M-Duino Arduino Function
Connector Pin
SCL 21 12C/SS
SDA 20 12C/SS
RX0 0 RX0/SS
TXO0 1 TX0/SS
™ 16 RX2(serial 2
RX 17 TX2(serial 2
Z- - RS485
Y+ = RS485
B- - RS485
A+ o RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 SI 51 SPI
52 SCK 52 SPI
Reset Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply

SCL/126
SDA/I25
wirt / 11.6
WIFL/ 1.5

Pin3/106
Pin2/105

RTC SCL

RTC SDA
OFF

Rev. 6: 03-12-2024

Configuration Switch® (see section 8 1o
eelect the correct configuration for
outputs. Enabling communications diables
some [105)

Fax1iTx1 = Pins used lor the WiFi module

Communicaton Pins

Power supply conneciors (24Vdc - GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.

21
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Ethernet Reset USB-B

RTC Programmable button

22



5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
1X.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)1X.6 GND IX.6
IX.6/INT Interrupt X In?
(-)IX.5 GND IX.5
IX.5/INT Interrupt X In?
(-)Ix.4 GND IX.4*
IX.4 Digital Input*
(-)Ix.3 GND IX.3
IX.3 Digital Input
(-)Ix.2 GND IX.2
1X.2 Digital Input
(-)1x.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors IX.12, IX.11 and 1X.4 are not connected (NC) in D Zone.

X
s
%3

Top Zone

%l
%10
%
X_'
%4
%

%

Kl
it
hit
it
%3
Hl

Led indicator 1/Os state

OCAAHT
W AT a-]

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out
QVvdc External Isolated Out Vdc
COoM(-) External Isolated Out GND
Qx.7 Digital/PWM Out*
QX.6 Digital/PWM Out
QX.5 Digital/PWM Out
Qx.4 Digital Out*
QXx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.0 Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.

* Maole: wse comectly monfgueation for

ust this signal

[E R LIHE H
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Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs {izolated)

Configuration Switch*

(s=e section 8 io select the corect
configuration for aulpuls).

Anabog Outputs
‘oltage Supply/Reference for

Digital/(PWM Outputs (isolated)

Digital Outputs
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5.3 Relay Zone connection (I/0s)

X Zone ]
M-Duino Function
Connector
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX.5 Rel?y Out* Relay Outputs
RX.4 Relay Out
AX.2 Analog Out*
AX.1 Analog Out
AX.0 Analog Out
GND GND
Qx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out
G | g,
- xternal Isolated Out Gn ,
QVvdc External Isolated Out Vdc 2"‘“‘."3 Quiputs {Switch
onfiguration)
*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.
Top one | Digital/PWh Cutputs {isclated)
oo N e T L U B R T N = -:
X X X X X X X X X
Led indicator 1/Os state
X Zone
M-Duino Connector Function
s%g Eg:gz 83'{ Relay Outputs
RX.1 Relay Out 1‘1:1’{.;
GND GND Advae
IX.5 Analog/Digital Input Digitat
IX.4 Analog/Digital Input -
IX.3 Analog/Digital Input B
IX.2 Analog/Digital Input § - 24Vt
IX.1/INT? Interrupt X In — ano
(-)Ix.1 GND IX.1 _ s o
|X.0/|NT4 Interrupt X In - :il Analog/Digital Inputs
(-)iX.0 GND IX.0 s o
jq o
© oo |
f N Interrupt Inputs {isolated)
83d  afNc
i ] s
§E E : :g Configuration Switch®
IR E = (see section & to select the comect
3 See section 5.4 to know more about interrupt pins. I configuration for outputs).
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See the Reference Table in order to know the specific device details.

Analog/Digital Relay
Zone PLC Input PLC Interrupt M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

0.6 INT1 PIN3 0.1 INT1 PIN3

° 0.5 INTO PIN2 0.0 INTO PIN2
1.5 INTS PIN19 - - -

¢ 1.6 INT4 PIN18 - - -
2.5 INT3 PIN21 2.1 INT3 PIN21

> 2.6 INT2 PIN20 2.0 INT2 PIN20

If WiFi is activated through switches, interrupts INT5 and INT4 will not work.

Check this link for more information.
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Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino
Editor language:
Editor font size:
Interface scale:
Theme:
Show verbose output during:

Compiler warnings:

Display line numbers
Verify code after upload

Check for updates on startup

Use accessibility features

Additional Boards Manager URLs:

More preferences can be edited directly in the file

/home/annal.arduinolS/preferences.txt

(edit only when Arduing is not running)

Browse

English (English) v (requires restart of Arduino)
12
Automatic % (requires restart of Arduino)
Default theme v (requires restart of Arduino)
compilation upload
None v

Enable Code Folding

Use external editor

Save when verifying or uploading
fapps.industrialshields.com/main/arduina/boards/package_industrialshields_indexjson
OK  Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Auto Format CtrtT
Archive Sketch
sketch_sep26

void setup FixEncoding &Reload

File Edit Sketch

11 put y manage Libraries... CtriShifts
} Serial Monitor CirbeShiftei
Serial Plotter Crlsshifil
void loop(
It put Ly:
PUT Y] wikit01 / WIFININA Firmware Updater ¥
}
Board: "M-Duino WiF/BT family” B Boards Manager.
WModel: "M-Duino 19R+ WIFI/BT" >
5 | Arduino AVR Boards >
. Industrial Shields boards > [ family
industrialshields-esp32 > | Ardbox DALI family
Programmer: *Arduino as ISP" >

Ardbox GPRS family
Burn Bootloader Ardbox WIFUBT family
Ardbox LoRa family
M-Duino family

M-Duino DALI family

M-Duino LoRa family

© WM-Duino WIFI/BT family

M-Duino WiFi/BT + GPRS famil

QM_

sketch_sep26|
void setup F

Cureshifst
) Cutsshiftin
e Culeshiftil
void loop(
1 t B
put y WIFi101 / WIFININA Firmware Updater Ly
¥
Board: “M-Duino WiFi/BT family >
Model: *M-Duino 19R+ WiFi/BT* >

Get Board Info

© M-Duino 58+ WIF/BT

7 on 0

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for WiFi
module.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields
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7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino WiFi/BLE Family uses B-USB cable.

Open Arduino IDE interface:

Select Industrial Shields boards -> M-Duino WIFI/BT Family

Select the correct M-Duino Board (M-Duino 58+W!IFI/BT in our example).

File Edit Sketch Help
Auto Format CtrisT
Archive Sketch
sketch_sep26;

void setup| FixEncoding & Reload

11 put Y manage Libraries.. Crrl+shift+1
) Serial Monitor Ctrhshifte
0l Serial Plotter Ctrhshiftel
voi 0op(|
17 put ly:

WIFi101 / WIFiNINA Firmware Updater

}

Board: 'M-Duino WFi/BT family" >

© W-Duino 19R+ WIFVBT
> | M-Duino 21+ WiFi/BT

Get Board Info M-Duino 38AR+ WiFI/BT

-Duino 38R+ WiFI/BT

Programmer: "Arduino as ISF" >
M-Duino 42+ WiFI/BT

Burn Boctloader

M-DUino SORRA+ WIFI/BT
M-Duino S3ARR+ WiFi/BT
IV-Duino S4ARA+ WIFIET

Vi £ WIFI/BT

M-Duino 57R+ WiF/BT

O M-Duino 58+ WiFi/BT

- Select the correct port.

File Edit Sketch |Tools Help

Auto Format Crrl+T

Archive Sketch

skelch_augl 4 Fix Encoding & Reload

tup (] Manage Libraries... CtrleShift+ |
Y51 Serial Monitor Crl+ Shift+ M

Serial Plotter Chrls Shifts L

WIFI101 / WiFiNINA Firrware Updater

// pat yoy Board: "M-Duine WiFVBT family” »
Model: “M-Duino 198+ WiFi/BT" »
Port | Serial ports
Get Board Info COMT72 (Arduino/Genuino Mega or Mega 2560)

Programmer: “Arduino as I5P° »
Bumn Bootloader
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8 How to connect PLC to power supply

- M-Duino WIFI/BLE Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSIBLE!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

B | ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- GND n-_l—ll "3“13'24 e }

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail: 4
-12vdc / 24vdc e ill

-2.5A R

-30W Sy
®.
L]
Industrial Shields power supplies provide parallel operation, overvoltage protection, and 8-
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.
iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone
Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
WiFi | XX WiFi XX
WiFi | XX WiFi XX
Pin 3 | XX Pin 3 XX
Pin 2 | XX Pin 2 XX
SD | XX SD XX
FD | HD FD HD
OFF ON
:S;;'é: This is an D Zone Switch example from M-Duino 58+ WIFI/BLE. In
Wi,:im_'s this case, SCL, SDA, 11.6, 11.5, 10.6, 10.5, Q2.0 and HD are enabled.
WiFi /11.5 This means SCL, SDA, WIFI, Pin 3, Pin 2, SD and FD are disabled.
PiN3/10.6
Pin2/10.5
SD Q20
FD RS485 HD
OFF ON

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

2. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and
disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi
connection

1. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and
disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi
connection.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and
disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone
Switch OFF ON
NC - - OFF ON
NC - -

NC NC

NC | RTC - RTC NC NC

NC | RTC - RTC o RTC

“RTC

This switch enables the communication with RTC using

I12C. Having both switches in ON mode activates the
communication, whereas if they are in OFF mode 12C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - ]
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 Qx.6
AX.5 | QX.5 AX.5 Qx.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
Al7 Q1.7
Ale Ql.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qax.2
AX.1| QX.1 AX.1 ax.1
AX.0 | QX.0 AX.0 Qx.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF OnN We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0l Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RXO0 0
TXO0 1
RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 I12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that
they are pull-up inputs (2200Q resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.3 SPI - MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.4 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.
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11 A Zone Features: Communications § RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here* or here® to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here® or here’ to see more about this communication.

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
5
6 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195
7

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 5050 50
MOSI 513l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX3/TX3/Pin2/Pin3 21/20/1/0/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here® to see more about this communication.

11.5TTL

M-Duino has two TTL ports, RX0/TX0, RX/TX. TTLO is accessed with the function Serial (pins O
and 1 of the Arduino Mega). TTL is accessed with the function Serial2 (pins 16 and 17 of the
Arduino Mega). See section 9 for more information.

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192

S https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

38



https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

Rev. 6: 03-12-2024

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10). Click here' and here™ to see more about this communication.

11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the I12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC. Click here to see more about this feature.

11.8uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip. Click here® to see more about this feature.

10 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103
1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
12 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.

11.9 WiFi & BLE

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power, 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
loT Sensor Hub, Generic Low-power loT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (loT) applications.
11.9.1 General Specifications:
Wi-Fi

e 802.11b/g/n
e 802.11 n (2.4 GHz), up to 150 Mbps

Bluetooth

® Bluetooth 4.2 BR/EDR BLE dual-mode controller
e +12 dBm transmitting power
® NZIF receiver with -97 dBm BLE sensitivity
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11.9.2 WiFi & Bluetooth Module Configuration

In order to configure the WiFi & BLE module, you must connect it to a PC. To connect it you will
need a micro USB to USB cable.

The slot for the micro USB input is located on the right side of your equipment.

To load the program into the ESP32 you have to use the appropriate board. For that, update

our board to the

latest version. Go to Tools -> Board -> Boards Manager. Search by

industrialshields-esp32.

Type  All

v | industrialshields-esp32

industrialshields-esp32

Boards included in this package:

WIFI/ET module, 10 I0s PLC

Online Help
More Info

family, ESP32 PLC family.

212 v Install

Now you are able to install the board. Go to Tools -> Boards -> industrialshields-esp32 -> WiFi

module.

File Edit Sketch

sketch_sep27,

Help

Auto Format Ctrl+T
Archive Sketch

void setup FxEncoding & Reload
/1 put Y manage Libraries... Crrl+Shift+
} Serial Monitor Ctrl+Shift+M
X Serial Plotter Ctrl+Shift+L
void loop(
/1 put ) - Ly:
WIFi101 / WIiFININA Firmware Updater
}

Board: "WiFi module” Boards Manager...

Arduino AVR Boards >
Get Board Info

Industrial Shields boards >

Programmer bl industrialshields-esp32 10105 PLC Family

Burn Bootloader ESP32 PLC Family

© WiFi module
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The internal connection between the ESP32 module and the Arduino Mega is the following:

Arduino Mega Pinout ESP32 Pinout
5Vvdc Vcc
GND GND
Tx1 (Pin 18) TxD
Rx1 (Pin 19) RxD

WiFi and Bluetooth are always enabled as there are no switches that configure it. The WiFi and
Bluetooth module uses Seriall for communication.

More information:

https://www.industrialshields.com/blog/arduino-industrial-1/post/esp32-bluetooth-ble-wifi-13
3
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12 Examples

12.1 Communication system between M-Duino and WiFi module

As seen in the chart above, a Serial TTL communication is used to interact between Arduino
Mega 2560 board and ESP32 module. In this blog", an introduction to this communication
between modules is done using an example code.

12.2 How to connect your ESP based PLC to Wi-Fi

If having problems connecting your ESP32 based PLC to Wi-Fi, follow this other blog®. There
you can find a brief description of the code provided and also an explanation about how the
ESP32 board and the Arduino shield are connected to each other.

12.3 Interact with M-Duino WiFi/BLE PLC via Bluetooth

To learn how to work with BLE from the ESP32 board, follow the instructions on this blog™. In
it, a useful example of usage of the BLE feature is explained. In addition, communication
between the M-Duino board and the ESP32 is also covered in the blog.

14

https://www.industrialshields.com/blog/arduino-industrial-1/post/communication-system-between-m-duino-and-wifi-module-148
15 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-your-esp32-based-plc-to-wi-fi-452

16 https://www.industrialshields.com/blog/arduino-industrial-1/post/interact-with-m-duino-wifi-ble-plc-via-bluetooth-480
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

" M-Duino WiFi/BLE
Family PLC

Tx

KRF C-6 Ferrite {4 Loops|
@:I“ o D'Tx
RS-232 p, \J)\__)\_‘) | Rx

CABLE

Ferrite KITA
GND

12/24v

13.2 RS-485 Communication:
13.2.1 Half Duplex

M-Duino WiFi/BLE_
Family PLC

KRFC-8 Ferrite (4 Loops)

en D

Ferrite KITA
GND I

12/24V

13.2.2 Full Duplex

" M-Duino WiFi/BLE

" Another Industrial '
| Shields PLC

RS-232

Fermite KITA

GND
12/24v

Another Industrial
Shields PLC [

RS-485

Ferite KITA
GND
W 12/24V

*_Another Industrial 7

KRFC-6 Ferrites (4 Loops)
LAY A
RS-485 Y L -y RS-485
OB
z k;, -2
o Ferrite KITA SHIELDED CABLES Ferrite KITA —
12/24V 12/24V

@OOOC
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Ethernet

13.3 Ethernet
KRFC-& Femite
1
M-Duino WiFi/BLE
Family PLC
Ferrite KITA

2y XK
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Another Industrial
Shields PLC

Fermrite KITA

(B OO o

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 4
Analog input 5.1
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15 I/0 technical details

A comparison between the waveforms of the I/Os from the M-Duino WiFi/BLE Family PLC and
the Arduino Mega is done in this section.

Digital Output Waveform:

T e |
L1

DIGITALOUT

CH1= 35, @aEn [LH = p=py=c ] M 288ms || CH1 % 286m0.

Digital Output Turn-off:

ARDANINO-OUT

CHi= 5. @al [CH: - epulsly M 288us || CH1 % Z6Em.)

PWM OUTPOUT

= ey ———
ARDUING PWR OUT

CH1= 35,@al MR 5. BEL M 1.868ms | CHL % 286m.
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

ARDUINODUT
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16 Typical Connections

GND N ()00
SM2124V o o J 0.0
SHIELDED CABLE

Ferrite KITA

= S— i e T

SHIELDED CAELE / Doursoad the MDUINO LAYOUT: \

Y

Ferrite KITA

= l 0 POWER
2204 B oomaw
SHIELDED CABLE ,J Duumbond oo MOURO LAYOUT:

48



SHIELDED CABLE

2024V a/c
GMND

Ferrite KIIA
224V B ocemAuANALOG W
- SHIELDED CABLE ~/  fexwewhaeeswen  \
' e U

Ferrite KITA
GND
cE )~
2r2av - DIMUTALANALOG IN
Dowrined e MOUNG LA YOUT:

SHIELDED CABLE
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010V
SHIELDED CABLE
@ 51224V %m—
GND
Ferrite KITA
GND {9
12124V

Ferrite KITA

0

ar

0.7
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SHIELDED CABLE

ALWAYS
CONNECTED
&
VOUT = Q/Vdc

SHIELDED CABLEf o wone tradata o \_
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SHIELDED CABLE

Gﬂb{ﬁ

2124V

Ferrite KIT/

Ferrite KITA
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VOUT = Q/Vde

SHIELDED CABLE

L
I
SHIELDED GAEL? o v e E

* Sew the swilch
configutarion (ON)
f 512124V
k o A
J ALWAYS
JU1 CONNECTED
SHIELDED CABLE

VOUT = Q/ Vide
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A
ALWAYS
DNMNECTED
Ferrte KITA
— GND :[9] POWER VOUT = 0/ Vide
24 I DAGTALPWM OUT
Dowrioad B MOURMO LAYOUT:

SHIELDED CABL Fom

\VJ .
SHIELDED CABLE

a0

e

\ * Analog Outs no led /

Qe * See the switch
) configutarion (OFF}

o8
o4 GND KF
o0

SHIELDED CABLE
NC|) O o2
Ferrite KITA \[:/
GND

i
POWER
S. 224V ¥ ]? I awwwosour
SHIELDED CABLE)

52



Rev. 6: 03-12-2024

17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529"
connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x0.8 mm
Pin spacing 2.5mm

7 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

18
https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=CjOKCQjw_viWBhD8ARIsAH1mCd4jlzLvlJs5K_3|EpaW5Ango3FBLULTwiPFtyKaiP-rj4LSly6
7bWoaAuLnEALwW_wcB

54


https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C603873204419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy67bWoaAuLnEALw_wcB

Rev. 6: 03-12-2024

We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 1803426 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC® is the
male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8x 0.8 mm

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=CjOKCQjw_viWBhD8ARISAH1mMCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX10fLpgsBx4mnoaAo9GEALwW_wcB

20
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=CjOK
CQjw_viWBhD8ARISAH1MCd6YjA37NgmaaFBXgbRyGEXfAM8gDodVOWZPfYsLLQhnVygDn8ufNslaAmgYE
Alw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807 & CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true
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18 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15

Top hot rail TH 35-15

154
155
-———] =004
15°
ROS
R12
RO8
o~
H
= —ed 1004
Sezione A / Section A R12
o~ 2,2 min. finoa / To 2,5 max
S| —e
1l
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisozn o JSTMDB38  MPo 68 Mechanical test Resistonce o torsil stess of yield ASTMDE3E P 68
Resishiwn o tazione o mttwo JTMDB3E  MPo 48 Tenslostength ASTMDE3E  WPa 48
Alongomento a rotvn JTMDB3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flaing modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 15016014 X/m'* 55
Termiche Temp di mmmolimento Vit mewdo B ASTM DISZS  °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 14
Tomperatu Ricot 1 B1 MRy KTHDe48  °C 7 Rebeating omperature 1.81 WPo ASTMDE4E  °C 7
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mould shrinkge ASTIDISE % 0405
Mk Flow Index 260°C - 98N KIMDIZ3E g0 111 Mkt Fow Indax 260°C - 98 ASTMDIZ38 g0’ 1.1
Comportamento Aubestinguerea (mm di spesor) s V-0(08) Flame test Self atinguisher (fhidkness in mm) [I[E2) V-0(08)
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondssien thiead 32 mm IECE9521  °C 90

Ialtronic si riserva il diitto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the moteriols without being obliged 1o forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with
IKO8 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

- If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes
0 26/07/2019 First implementation
1 02/03/2020 Second implementation
2 08/06/2022 Third implementation
3 30/09/2022 M-Duino W:::ﬁ;.;::‘ir;itl?/olr:ser Manual
4 11/03/2024 Added section 14 “Digital inputs threshold detection”
5 26/09/2024 Added section 3.4 (“Isolation Precautions”)
6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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The M-Duino DALI Family PLCs are Open Type Controllers. It is required that you install
the M-Duino DALI PLC in a housing, cabinet, or electric control room. Entry to the
housing, cabinet, or electric control room should be limited to authorised personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when installing M-Duino
family PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des contrbleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de Ia
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

o Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e QOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.

IS
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct manner. It
must respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS's test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and
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when all of the protective devices are used. These components may only be handled by
qualified and trained technical personnel who are knowledgeable and observe all of the safety
information and instructions on the components and in the associated technical user
documentation. When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual risks
associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED
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Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:

UL Std. 61010-1
eTb UL Std. 61010-2-201

c us Cert. To CSA Std. C22.2 No. 61010-1

TS Cert. ToCSA Std. C22.2 No0.61010-2-201

Intertek

Place for control

number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO DALI product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and D the shield from above. Having a B and a C in the middle of them.

HE EEE]
il i
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wwse B ZONE
(- r=miroi A ZONE

e The inputs in zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as RO.X.

e The inputs in zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X.

e The inputs in zone D are named 12.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X.

10
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Reference Table

Model Reference

PLC M-Duino General Family
M-Duino PLC Arduino Ethernet & DALI 19R 1/Os Analog / Digital Plus 004001000100
M-Duino PLC Arduino Ethernet & DALI 21 1/Os Analog / Digital Plus 004001000200
M-Duino PLC Arduino Ethernet & DALI 38AR |/Os Analog / Digital Plus 004001000700
M-Duino PLC Arduino Ethernet & DALI 38R 1/Os Analog / Digital Plus 004001000300
M-Duino PLC Arduino Ethernet & DALI 42 1/Os Analog / Digital Plus 004001000400
M-Duino PLC Arduino Ethernet & DALI 50RRA I/Os Analog / Digital Plus 004001000900
M-Duino PLC Arduino Ethernet & DALI 53ARR 1/Os Analog / Digital Plus 004001001000
M-Duino PLC Arduino Ethernet & DALI 54ARA I/Os Analog / Digital Plus 004001001100
M-Duino PLC Arduino Ethernet & DALI 57AAR 1/Os Analog / Digital Plus 004001000800
M-Duino PLC Arduino Ethernet & DALI 57R 1/Os Analog / Digital Plus 004001000500
M-Duino PLC Arduino Ethernet & DALI 58 1/Os Analog / Digital Plus 004001000600

To find the reference of your M-Duino DALI PLC, check the arrow in the picture below. In the

example, the reference is:

11
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Zones Table
Model Zone A Zone B Zone C Zone D

M-Duino DALI PLC 19R+ v Relay - -

M-Duino DALIE PLC 21+ v Analog / Digital - -
M-Duino DALI PLC 38AR+ v Analog / Digital Relay -

M-Duino DALI PLC 38R+ v Relay Relay -

M-Duino DALI PLC 42+ v Analog / Digital | Analog / Digital -
M-Duino DALI PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino DALI PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino DALI PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino DALI PLC 57AAR+ v Analog / Digital | Analog / Digital Relay

M-Duino DALI PLC 57R+ v Relay Relay Relay

M-Duino DALI PLC 58+ v Analog / Digital | Analog / Digital | Analog / Digital

The distribution of the different features that provide the M-Duino DALI PLC Family is the

following one:

Shield B Zone C Zone D Zone
13 Inputs 11 Inputs 10 Inputs
(13 Digital Inputs, 6 (11 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
8 Outputs 8 Outputs 6 Outputs
(8 Digital Outputs, 3 | (8 Digital Outputs, 3 | (6 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
6 inputs 4 inputs 6 inputs
(6 Digital Inputs, 4 of | (4 Digital Inputs, 4 of | (6 Digital Inputs, 4 of
which can work as which can work as which can work as
Analog Input) Analog Input) Analog Input)
Relay Shield
3 Outputs 3 Qutputs 2 Outputs
(3 Digital Outputs, 3 | (3 Digital Outputs, 3 | (2 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Output)
8 Relays 8 Relays 7 Relays

12
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Shield

A Zone

Communication

Shield

(1x) Ethernet
(1x) USB
(1x) 12C

(1x) TTL

(1x) RS-232

(1x) SPI external Port
(1x) RTC
(1x) uSD Socket

(1x) HALF/FULL Duplex RS-485

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) | Depth (mm) | Max weight (g)
M-Duino DALI PLC 19R+ 119.5 70.1 101 394
M-Duino DALIE PLC 21+ 119.5 70.1 101 394
M-Duino DALI PLC 38AR+ 119.5 94.7 101 504
M-Duino DALI PLC 38R+ 119.5 94.7 101 504
M-Duino DALI PLC 42+ 119.5 94.7 101 504
M-Duino DALI PLC 50RRA+ 119.5 119.3 101 614
M-Duino DALI PLC 53ARR+ 119.5 119.3 101 614
M-Duino DALI PLC 54ARA+ 119.5 119.3 101 614
M-Duino DALI PLC 57AAR+ 119.5 119.3 101 614
M-Duino DALI PLC 57R+ 119.5 119.3 101 614
M-Duino DALI PLC 58+ 119.5 119.3 101 614

13
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CONNECTABLE PLC ARDUINO 24Vcc M-DUINO
MODEL TYPE Controller General Specifications Information
12 to 24Vvdc Fuse protection (2.5A)
InPUt VOItage - = Polarity protection
Input rated voltage 2_4&
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
N I2C — Ethernet Port — USB — RS485 — RS232 — SPI — (1x)
Communications

USB consideration!

RX, TX (Arduino pins) — DALI

Max232-Max485-W5500

Only meant for uploading or debugging, not always
connected as a serial in a project!

0 to 10Vdc

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcc)

Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10vVdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

5 to 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

5 to 24Vvdc

All Digital Inputs are PNP.
Click here' for more information.

Max read time: 8us

* Interrupt isolated

I'min: 2 to 12mA

Galvanic Isolation e e
Input HS (24Vcc) Rated Voltage: 24Vdc
0 to 10Vdc
| max: 20mA Output frequency: 2Hz
Analog Output 8bit Separated PCB ground
(0-10Vcc)

Rated Voltage: 10vdc

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410mA
With 70us delay,
freq is 6.849MHz
with pulse width of 106us

Rising edge time: 476ns

Falling edge time: 42.8us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193

14
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30Vdc / 250Vac
Digital Isolated Output Galvanic Isolation Imax: 3A (30Vdc)
Relay Diode protected for Relay Imax: 5A (250Vac)
5 to 24Vdc
| max: 70mA
PWM Isolated Output Galvanic Isolation
8bit (24Vce) Diode Protected for Relay

Rated Voltage: 24Vdc

Max frequency: 77kHz

Direct Arduino Pin DB
Output I max: 40mA Rising edge time: 200ns
u . .
. Rated Voltage: SVdc Falling edge time: 200ns
Direct Arduino Pin Dim B _
| max: 40mA Max read time: 8us
Input Rated Voltage: 5Vdc
12C Pin Max frequency: 100kHz
5V Pull-up Rising edge time: 10us
Falling edge time: 150ns
Usable pins:
One-Wire Pin Pin 2, Pin3, SCL, SDA, RX0, TXO, Frequency: 800kHz

MISO, MOSI, SCK

Expandability 12C - 127 elements - Serial Port R$232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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1.7 Power consumption of the M-Duino DALI Family PLCs

Model Current resting | Power resting Current active Power active
(mA) (W) (mA) (W)

21+ 99 2,376 120 2,88
42+ 92 2,208 128 3,072
58+ 76 1,824 126 3,024
19R+ 80 1,92 202 4,848
38R+ 77 1,848 313 7,512
57R+ 73 1,752 425 10,2
38AR+ 72 1,728 221 5,304
53ARR+ 71 1,704 323 7,752
57AAR+ 71 1,704 221 5,304
54ARA+ 76 1,824 231 5,544
50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs.”

16




2 Technical Specifications:

2.1 General Specifications:
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Item M-Duino DALI Family PLC
Power supply
D! I 12 to 24V
voltage C power supply to dc
Operating
11.4 to 25.4vdc ===
voltage range DC power supply
Power DC power suppl 30W max
consumption P pPPly '
Power supply —
24Vdc -——
External power voltage
supply
Power suppl.y 700mA
output capacity
Insulation resistance 20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external
AC terminals and the protective ground terminal.

Shock resistance 80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 02 to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas
Ambient temperature (storage) -2092 to 60°C
Power supply holding time 2ms min.
Weight Check size and weight table

2.2 Performance Specification:

Arduino Board ARDUINO MEGA 2560
Control method Stored program method
1/0 control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560
Flash Memory 256KB of which 8KB are used by the bootloader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz

17
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Table that includes all the symbology that is used in the serigraph of the M-Duino DALI PLC

Family:
Standard No. /
Sl Standard Title
IEC 60417 / Graphical
|
symbols for use on
HE B . .
equipment
IEC 60417 / Graphical
N symbols for use on

equipment

IEC 60417 / Graphical
symbols for use on
equipment

IEC 60417 / Graphical
symbols for use on
equipment

IEC 60417 / Graphical
symbols for use on
equipment
2004/108/EC /

Electromagnetic
Compatibility

C ISO 7000/ Graphical

symbols for use on
equipment

ISO 7000/ Graphical
symbols for use on
equipment

Standard Reference
No. / Symbol Title

5031 / Direct Current

5032 / Alternating

Current

5130 / Pulse General

5017 / Earth, Ground

5115 / Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only; to
identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant terminals

To identify the control by which a
pulse is started.

To identify an earth (ground)
terminal in cases where neither the
symbol 5018 nor 5019 is explicitly
required.

To identify the switch by means of
which the signal lamp(s) is (are)
switched on or off.

CE marking indicates that a product
complies with applicable European
Union regulations

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

To indicate hazards arising from
dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino DALI PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino DALI Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in
this manual. Before using M-Duino under different conditions from what has been specified in
this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of M-Duino are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
double safety mechanisms. This manual provides information for programming and operating
the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

19
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4 M-Duino Pinout
10s Table
Model Reference Analog Digital Isolated Digital Isolated Digital/Analog Relay Output PWM Isolated
Input*’ Input Output Output Output*?

19R+ 004001000100 4 2 0 3 8 3

21+ 004001000200 6 7 8 3 0 3
38AR+ 004001000700 10 7 5 6 8 6

38R+ 004001000300 8 2 0 3 16 6

42+ 004001000400 12 12 10 6 0 6
SORRA+ 004001000900 12 4 8 16 8
53ARR+ 004001001000 14 8 15 8
54ARA+ 004001001100 14 13 9 8 8 8
57AAR+ 004001000800 16 14 10 8 7 8

57R+ 004001000500 12 4 0 8 23 8

58+ 004001000600 16 18 14 8 0 8

*1 The analog inputs can also be used as digital inputs.

*2The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base
A Zone
M-Duino Arduino Function
Connector Pin
AREF AREF Arduino Pin
sQwW SQW Arduino Pin
3.3Vdc 3.3Vdc Arduino Pin
5Vdc 5Vdc -
GND GND GND
Base
A Zone
M-Duino Arduino Function
Connector Pin
SCL 21 12C/SS
SDA 20 12C/SS
RX0 0 RX0/SS
TXO0 1 TX0/SS
™ 16 RX2(serial 2
RX 17 TX2(serial 2
Z- - RS485
Y+ = RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51l 51 SPI
52 SCK 52 SPI
Reset Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply
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Canfiguration Swilch® {see section B 1o
selest the comest configuratian for
aulputs. Enabling communications dablas
same [10s),

Communication Fins

Powar supply connecions (24Vde - GNDY)
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any
device.

: WRTC Battery CRIZZ)

Ethernet Reset USB-B

RTC battery Programmable button
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5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
1X.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)1X.6 GND IX.6
IX.6/INT Interrupt X In?
(-)IX.5 GND IX.5
IX.5/INT Interrupt X In?
(-)IX.4 GND IX.4*
IX.4 Digital Input*
(-)1x.3 GND IX.3
IX.3 Digital Input
(-)IX.2 GND IX.2
IX.2 Digital Input
(-)Ix.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors 1X.12, 1X.11 and IX.4 are not connected (NC) in D Zone.

Top Zone

2 @ w = w
< = = = = b =

%
it
K5
it
%l

P

Led indicator 1/Os state

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out
QVvdc External Isolated Out Vdc
COoM(-) External Isolated Out GND
Qx.7 Digital/PWM Out*
QX.6 Digital/PWM Out
QX.5 Digital/PWM Out
Qx.4 Digital Out*
QXx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.0 Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.

* Maole: wse comectly monfgueation for

ust this signal

[E R LIHE H
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Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isclated)

Configuraticn Switch®

{see section & to select the corect
configuration for outputs).

Analog Outputs
‘oltage Supply/Reference for

Digital/PWHM Outputs (isalated)

Digital Cutputs
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5.3 Relay Zone connection (I/0s)

X Zone ]
M-Duino Function
Connector
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX.5 Rel?y Out* Relay Dutputs
RX.4 Relay Out
AX.2 Analog Out*
AX.1 Analog Out
AX.0 Analog Out
GND GND
Qx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out
)| gnEO,
- xternal Isolated Out Gn -
Qvdc External Isolated Out Vdc Analog D".lp”w (Switch
Configuration)
*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.
Top one ] DigitallPWh Outputs (isolated)
oo N e T L U B R T N = -:
X X X X X X X X X
Led indicator 1/Os state
X Zone
M-Duino Connector Function
RX.3 Relay Out Relay Outputs
RX.2 Relay Out
RX.1 Relay Out 1‘1:1’{.;
GND GND B 10vde
IX.5 Analog/Digital Input Digitat
IX.4 Analog/Digital Input -
IX.3 Analog/Digital Input B
IX.2 Analog/Digital Input § - 24Vt
IX.1/INT? Interrupt X In — ano
(F)ix.1 GND IX.1 _ S .
IX.0/INT? Interrupt X In e i Analog/Digital Inputs
(-)iX.0 GND IX.0 s o
jq o 161
© oo .
f N Interrupt Inputs (isolated)
8EE  _fc
Tk ]
55 i 2 E Canfiguration Switch®
| = E E 1 [see sechon 8 lo select the correct
3 See section 5.4 to know more about interrupt pins. I configuration for outputs).
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5.4 Interrupt equivalence table

Rev. 5: 03-12-2024

See the Reference Table in order to know the specific device details.

Analog/Digital Relay
PLC i . . .
Zone PLC Input M-Duino Pin PLC Input | PLC Interrupt M-Duino Pin
Interrupt

0.6 INT1 PIN3 0.1 INT1 PIN3
B

0.5 INTO PIN2 0.0 INTO PIN2
C

2.5 INT3 PIN21 2.1 INT3 PIN21
D

2.6 INT2 PIN20 2.0 INT2 PIN20

Check this link for more information.
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Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino
Editor language:
Editor font size:
Interface scale:
Theme:
Show verbose output during:

Compiler warnings:

Display line numbers
Verify code after upload

Check for updates on startup

Use accessibility features

Additional Boards Manager URLs:

More preferences can be edited directly in the file

/home/annal.arduinolS/preferences.txt

(edit only when Arduing is not running)

Browse

English (English) v (requires restart of Arduino)
12
Automatic % (requires restart of Arduino)
Default theme v (requires restart of Arduino)
compilation upload
None v

Enable Code Folding

Use external editor

Save when verifying or uploading
fapps.industrialshields.com/main/arduina/boards/package_industrialshields_indexjson
OK  Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch Help

Auto Format CirkT
Archive Sketch
sketch_octost

void setup FieEncoding & Reload

11 put ¥ Manage Libraries... Ctri+Shift+l
} Serial Monitor Ctrl+shifesM
. Serial Plotter CurlshiftsL
void loop(
It put Ly:
PUT Y] Wiki101 / WiENINA Firmware Updater v
}
Board: "M-Duino DALI family" B 50ards Manager..
Model: "M-Duino 19R+ DALI" >
| Arduino AVR Boards >
N Industrial Shields boards > Ardbox family
Get Board Info ’
ndustrial Shields ESP32 > | ) Ardbox DALI family
Programmer: *Arduino as 15P" > Ardbox GPRS family
Burn Bootloader Ardbox WiFI/BT family

M-Duino family

© M-Duino DALI family

M-Duino GPRS family

M-Duino WiFi/BT family

M-Duino WiFI/BT + GPRS family

Spartan family

Once it is selected M-Duino DALI Family, an extra option will appear on Tools:
There, it can be selected the exact model for every family.

ute Format Curl+T

Archive Sketch

sketch_oct06;
void setup| Fix Encoding & Reload

/1 put ¥ Manage Libraries.. Ctrl+Shift+
) Serial Monitor CtrheshifteM

. Serial Plotter Ctri+shift+L
void loop(

77 put y Ly:

WiFi101 /WiFININA Firmware Updater

}

Board: "M-Duino DALI family" >
Model: "M-Duino 19R+ DALI" > | @ M-Duine 19R+ DALL
> M-Duino 21+ DAL
Get Board Info IM-Duino 38AR+ DALT
. I-Duino 38R+ DALL
Programmer: “Arduino as ISP” >
-Duing 42+ DAL
Burn Bootloader
M-DUinG SORRA+ DALI
M-Duino 53ARR+ DALI
M-Duino 54ARA+ DALI
M-DuinG S7AAR+ DALI
M-Duino 57R+ DALL

M-Duino 58+ DAL

Also there are some examples of programming in File -> Examples -> Examples for M-Duino
DALI family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.
https://github.com/Industrial-Shields
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7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino DALI Family uses B-USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino DALI Family

- Select the correct M-Duino Board (M-Duino 19R+ DALI in our example).

UM_

sketch_octo6t]
void setup FixEnco

71 PUt Y| Manage Cutsshiftst
) s Culshiftrit
Serial Plotter Ctrl+Shift+L
void loop(|
/1 put Ly:
3 v 'WiFi101 / WIiFININA Firmware Updater y
¥

Board: "\

AL family

Programmer: "Arduino as ISP >

Burn Bootloader

M-Duino S4ARA+ DALL

0 STAAR+ DALL

M-Duino 7R+ DALL

M-Duino 58+ DAL

- Select the correct port.

File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
sketch_jul21al

w0id setup() | FixEncoding & Reload
/7 put your

Manage Libraries... Ctrl+Shift+T
i Serial Monitor Crl+Shiftrh
woid loop() { serial Plotter Ctri+shiftrL
/1 put your
b WiFi101 / WIFININA Firmware Updater
Board: "M-Duino family" >
Model: "M-Duino 58+" >

Port; "/devittyACMO (Arduino Mega or Mega 2560)" >
Get Board Info /devittyACMO (Arduino Mega or Mega 2560)

Programmer >

Burn Bootloader
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8 How to connect PLC to power supply

- M-Duino DALI Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSIBLE!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

B | ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- GND n-_l—ll "3“13'24 e }

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail: 4
-12vdc / 24vdc e ill

-2.5A R

-30W Sy
®.
L]
Industrial Shields power supplies provide parallel operation, overvoltage protection, and 8-
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.
iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications
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A Zone
Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
DALI | - DALI -
DALI | - DALI -
Pin 3 | XX Pin 3 XX
Pin 2 | XX Pin 2 XX
SD | XX SD XX
FD | HD FD HD
OFF ON
zgki'ég This is an D Zone Switch example from M-Duino 58+ DALLI. In this
oel case, SCL, SDA, 10.6, 10.5, Q2.0 and HD are enabled. This means SCL,
DAL SDA, Pin 3, Pin 2, SD and FD are disabled.
Pin3/10.6
Pin2/10.5
SD/ Q2.0
FD RS485 HD
OFF ON

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.
2. DALI | - : Always at OFF position.

1. DALI | - : Always at OFF position.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and
disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone OFF ON
Switch OFF ON NC NC
NC - - NC NC
NC - - o RTC
NC | RTC - RTC ~RTC
NC | RTC - RTC

This switch enables the communication with RTC using I12C. Having both switches in ON mode
activates the communication, whereas if they are in OFF mode 12C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - ]
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 Qx.6
AX.5 | QX.5 AX.5 Qx.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
Al7 Q1.7
Ale Ql.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qax.2
AX.1| QX.1 AX.1 ax.1
AX.0 | QX.0 AX.0 Qx.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF OnN We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0l Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RXO0 0
TXO0 1
RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 I12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that
they are pull-up inputs (2200Q) resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, USB communication is normally required for debugging or
uploading/updating the program. If using both interfaces at the same time the Arduino board
will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.3 SPI - MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.4 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.
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11 A Zone Features: Communications § RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here* or here® to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here® or here’ to see more about this communication.

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
5
6 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195
7

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.
11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX3/TX3/Pin2/Pin3 21/20/1/0/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here® to see more about this communication.

11.5TTL

M-Duino has two TTL ports, RX0/TX0, RX/TX. TTLO is accessed with the function Serial (pins O
and 1 of the Arduino Mega). TTL is accessed with the function Serial2 (pins 16 and 17 of the
Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10). Click here'® and here'! to see more about this communication.

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
K https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
10 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

Click here® to see more about this feature.
11.8uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch isin ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here® to see more about this feature.

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.
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12 Examples

12.1 Lighting Protocol DALI in a PLC Arduino

To know what the DALI Protocol is and how it works in an industrial environment, look at this
post™. A detailed description of DALI is done in it.

12.2 How to work with DALI Arduino Library and an industrial PLC

In this other link® a useful explanation on how the DALI Protocol can be implemented and used
in industrial PLCs is given. Also, there is an example code to help in understanding the
fundamentals of DALI communication.

14

https://www.industrialshields.com/blog/arduino-industrial-1/post/lighting-protocol-dali-in-a-plc-arduino
-238

15

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-work-with-dali-arduino-librar
y-and-an-industrial-plc-221
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

M-Duino DALI Another Industrial

Family PLC Shields PLC
KRFC-6 Ferrile (4 L

Tx

RS-232 o RS-232

Fermta KITA

Fermite KITA
12/24V - - @‘M 1224V

13.2 RS-485 Communication:

13.2.1 Half Duplex

M-Duino DALI Another Industrial

Family PLC Shields PLC
KRFC-6 Farrile (4 Loops)

LAY - A
o § DTS
HIELDEL A
Ferrite KITA Ferrite KITA
GND ~, -~ - . H GND
oy XTI OO taav

13.2.2 Full Duplex

M-Duino DALI " Another Industrial
Family PLC Shields PLC

KRFC-6 Ferrites (4 Loops)

Farrite KITA

- Farrite KITA 5 Y GND

A e T o)
B v’ B
RS-485 RS-485
Y e e Y
Z \,..’*-_.-’ﬂ,z
ILES

42



Rev. 5: 03-12-2024

13.3 Ethernet
M-Duino DALI Another Industrial
KRFC-6 Ferrites {4 Loops)
S A
RS-485 2% Rsass
Z
Farrite KITA Farrite KITA

2w X FRHOO iy

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 4
Analog input 5.1
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15 I/0 technical details

A comparison between the waveforms of the 1/0s from the M-Duino DALI Family PLC and the
Arduino Mega is done in this section.

Digital Output Waveform:

S G704, Bhs e ——
v

DIGITAL OUT

CH1= 35,060 L H: - sl M Z268ms CH1 % 2E806m.)

Digital Output Turn-off:

DIGITALOUT

ARDUINOOUT

CH1z S.@al) [CH. - e = M 268us CH1 % Z6@Em.

-

PWH OUTPOUT

M 1.868ms [ CHL ¥ 2800
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

ARDUINODUT
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16 Typical Connections

GND N ()00
SM2124V o o J 0.0
SHIELDED CABLE

Ferrite KITA

= S— i e T

SHIELDED CAELE / Doursoad the MDUINO LAYOUT: \

Y

Ferrite KITA

= l 0 POWER
2204 B oomaw
SHIELDED CABLE ,J Duumbond oo MOURO LAYOUT:
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2024V a/c
GMND

Ferrite KIIA
224V B ocemAuANALOG W
- SHIELDED CABLE ~/  fexwewhaeeswen  \
' e U

Ferrite KITA
GND
cE )~
2r2av - DIMUTALANALOG IN
Dowrined e MOUNG LA YOUT:

SHIELDED CABLE
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SHIELDED CABLE

ALWAYS
CONNECTED
&
VOUT = Q/Vdc

SHIELDED CABLEf o wone tradata o \_

48



SHIELDED CABLE

Gﬂb{ﬁ

2124V

Ferrite KIT/

Ferrite KITA

Rev. 5: 03-12-2024

VOUT = Q/Vde

SHIELDED CABLE

L
I
SHIELDED GAEL? o v e E

* Sew the swilch
configutarion (ON)
f 512124V
k o A
J ALWAYS
JU1 CONNECTED
SHIELDED CABLE

VOUT = Q/ Vide
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A
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Ferrte KITA
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24 I DAGTALPWM OUT
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\VJ .
SHIELDED CABLE
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e
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o4 GND KF
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529
connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x0.8 mm
Pin spacing 2.5mm

'8 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

17
https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=CjOKCQjw_viWBhD8ARIsAH1mCd4jlzLvlJs5K_3|EpaW5Ango3FBLULTwiPFtyKaiP-rj4LSly6
7bWoaAuLnEALwW_wcB
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MCV 1,5/ 2-G-3,81 1803426 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC" is the

male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8x0.8 mm

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

18

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=CjOKCQjw_viWBhD8ARISAH1mMCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX10fLpgsBx4mnoaAo9GEALwW_wcB

19
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=CjOK
CQjw_viWBhD8ARISAH1MCd6YjA37NgmaaFBXgbRyGEXfAM8gDodVOWZPfYsLLQhnVygDn8ufNslaAmgYE
Alw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807 & CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true
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18 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15

Top hot rail TH 35-15

154
155
-———] =004
15°
ROS
R12
RO8
o~
H
= —ed 1004
Sezione A / Section A R12
o~ 2,2 min. finoa / To 2,5 max
S| —e
1l
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisozn o JSTMDB38  MPo 68 Mechanical test Resistonce o torsil stess of yield ASTMDE3E P 68
Resishiwn o tazione o mttwo JTMDB3E  MPo 48 Tenslostength ASTMDE3E  WPa 48
Alongomento a rotvn JTMDB3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flaing modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 15016014 X/m'* 55
Termiche Temp di mmmolimento Vit mewdo B ASTM DISZS  °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 14
Tomperatu Ricot 1 B1 MRy KTHDe48  °C 7 Rebeating omperature 1.81 WPo ASTMDE4E  °C 7
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mould shrinkge ASTIDISE % 0405
Mk Flow Index 260°C - 98N KIMDIZ3E g0 111 Mkt Fow Indax 260°C - 98 ASTMDIZ38 g0’ 1.1
Comportamento Aubestinguerea (mm di spesor) s V-0(08) Flame test Self atinguisher (fhidkness in mm) [I[E2) V-0(08)
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondssien thiead 32 mm IECE9521  °C 90

Ialtronic si riserva il diitto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the moteriols without being obliged 1o forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with
IKO8 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes
0 30/07/2020 First implementation
1 11/08/2020 Added DALI Communication
2 05/10/2022 M-Duino DALI Family User Manual Implementation
3 11/03/2024 Added section 14 “Digital inputs threshold detection”
4 26/09/2024 Added section 3.4 (“Isolation Precautions”)
5 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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The M-Duino GPRS Family PLCs are Open Type Controllers. It is required that you install
the M-Duino GPRS PLC in a housing, cabinet, or electric control room. Entry to the
housing, cabinet, or electric control room should be limited to authorised personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when installing M-Duino
family PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des contrbleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de Ia
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

o Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e QOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.

IS
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct manner. It
must respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS's test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:

UL Std. 61010-1
qb UL Std. 61010-2-201

c us Cert. To CSA Std. C22.2 No. 61010-1

e Cert. ToCSA Std. C22.2 No.61010-2-201

Intertek

Place for control

number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO GPRS product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and D the shield from above. Having a B and a C in the middle of them.:

i EE0d
[T
W wwy
i = £ 5 Z
8608 ‘ 8855
<m0 T 'D ZONR O @ <
e 'C ZONE
wesn o | B ZONE
{ mi@.y 'AZONE

o The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X

10
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Reference Table

Model Reference
PLC M-Duino General Family
M-DUINO PLC Arduino Ethernet & GPRS 19R I/Os Relay / Analog / Digital PLUS 006001000100
M-DUINO PLC Arduino Ethernet & GPRS 21 1/Os Analog/Digital PLUS 006001000200
M-DUINO PLC Arduino Ethernet & GPRS 38AR I/Os Relay / Analog / Digital PLUS 006001000700
M-DUINO PLC Arduino Ethernet & GPRS 38R 1/Os Relay / Analog / Digital PLUS 006001000300
M-DUINO PLC Arduino Ethernet & GPRS 42 1/Os Analog/Digital PLUS 006001000400
M-DUINO PLC Arduino Ethernet & GPRS 50RRA 1/Os Relay / Analog / Digital PLUS 006001000900
M-DUINO PLC Arduino Ethernet & GPRS 53ARR I/Os Relay / Analog / Digital PLUS 006001001000
M-DUINO PLC Arduino Ethernet & GPRS 54ARA 1/Os Relay / Analog / Digital PLUS 006001001100
M-DUINO PLC Arduino Ethernet & GPRS 57AAR I/Os Relay / Analog / Digital PLUS 006001000800
M-DUINO PLC Arduino Ethernet & GPRS 57R 1/Os Relay / Analog / Digital PLUS 006001000500
M-DUINO PLC Arduino Ethernet & GPRS 58 I/Os Analog/Digital PLUS 006001000600

To find the reference of your M-Duino GPRS PLC, check the arrow in the picture below. In the

example, the reference is:

11




1.3 Zones Table
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Zones Table
Model Zone A Zone B Zone C Zone D

M-Duino GPRS PLC 19R+ v Relay - -

M-Duino GPRS PLC 21+ v Analog / Digital - -
M-Duino GPRS PLC 38AR+ v Analog / Digital Relay -

M-Duino GPRS PLC 38R+ v Relay Relay -

M-Duino GPRS PLC 42+ v Analog / Digital | Analog / Digital -
M-Duino GPRS PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino GPRS PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino GPRS PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino GPRS PLC 57AAR+ v Analog / Digital | Analog / Digital Relay

M-Duino GPRS PLC 57R+ v Relay Relay Relay

M-Duino GPRS PLC 58+ v Analog / Digital | Analog / Digital | Analog / Digital

The distribution of the different features that provide the M-Duino GPRS PLC Family is the

following one:

Shield B Zone C Zone D Zone
12 Inputs 11 Inputs 10 Inputs
(12 Digital Inputs, 6 (11 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
8 Outputs 8 Outputs 6 Outputs
(8 Digital Outputs, 3 | (8 Digital Outputs, 3 | (6 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
5 inputs Sinputs 6 inputs
(5 Digital Inputs, 4 of | (5 Digital Inputs, 4 of | (6 Digital Inputs, 4 of
which can work as which can work as which can work as
Analog Input) Analog Input) Analog Input)
Relay Shield
3 Outputs 3 Outputs 2 Outputs
(3 Digital Outputs, 3 | (3 Digital Outputs, 3 | (2 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Output)
8 Relays 8 Relays 7 Relays

12



1.4 A Zone Features
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Shield

A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) GPRS/GSM

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) | Depth (mm) | Max weight (g)

M-Duino GPRS PLC 19R+ 119.5 70.1 101 394
M-Duino GPRS PLC 21+ 119.5 70.1 101 394
M-Duino GPRS PLC 38AR+ 119.5 94.7 101 504
M-Duino GPRS PLC 38R+ 119.5 94.7 101 504
M-Duino GPRS PLC 42+ 119.5 94.7 101 504
M-Duino GPRS PLC 50RRA+ 119.5 119.3 101 614
M-Duino GPRS PLC 53ARR+ 119.5 119.3 101 614
M-Duino GPRS PLC 54ARA+ 119.5 119.3 101 614
M-Duino GPRS PLC 57AAR+ 119.5 119.3 101 614
M-Duino GPRS PLC 57R+ 119.5 119.3 101 614
M-Duino GPRS PLC 58+ 119.5 119.3 101 614

13
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO
MODEL TYPE Controller General Specifications Information
Fuse protection (2.5A)
Input Voltage 12 to 24vdc Polarity protection
24vdc
Input rated voltage —
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
C icati 12C — Ethernet Port — USB — RS485 — RS232 — SPI — (3x) Max232-Max485-W5500 -
ommunications RX, TX (Arduino pins) Sim800L
. . Only meant for uploading or debugging, not always Cannot be working in a final
1
USB consideration! connected as a serial in a project! application
0 to 10Vdc

Input Impedance: 39K
Separated PCB ground

Rated Voltage: 10Vdc
An/Dig Input 10bit

Max read time: 116us
(0-10Vcc)

5 to 24Vvdc
I'min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

*Check Section 14 for digital
inputs threshold detection

5 to 24Vdc
I min: 2 to 12mA All Digital Inputs are PNP.
Digital Isolated Input Galvanic Isolation Click here! for more information.
(24Vcc) Rated Voltage: 24Vdc
— Max read time: 8us
5 to 24Vdc
. I min: 2 to 12mA
* Interrupt isolated Galvanic Isolation
Input HS (24Vvcc)

Rated Voltage: 24Vdc

Max read time: 8us

0 to 10Vdc
| max: 20mA Output frequency: 2Hz
Analog Output 8bit Separated PCB ground
(0-10Vcc)

Rated Voltage: 10Vdc

Rising edge time: 150ms
Falling edge time: 252ms
5 to 24Vdc Imax 24Vdc: 410mA
Gallvr::s;(c: I7s(c)>rlzgon LRI
Digital Isolated Output : freq is 6.849MHz
Diode Protected for Relay . .
(24Vcc) Rated Voltage: 24Vdc with pulse width of 106us
=== Rising edge time: 476ns
Falling edge time: 42.8us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
| max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vvdc
| max: 40mA
Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin itttz ,
| max: 40mA Max read time: 8us
InpUt Rated Voltage: 5Vdc
12C Pin Max frequency: 100kHz

5V Pull-up

Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin

Usable pins:
Pin3, SCL, SDA, RX0, TXO,
MISO, MOSI, SCK

Frequency: 800kHz

Expandability

12C-127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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1.7 Power consumption of the M-Duino LoRa Family PLCs

Model Current resting | Power resting Current active Power active
(mA) (W) (mA) (W)

21+ 99 2,376 120 2,88
42+ 92 2,208 128 3,072
58+ 76 1,824 126 3,024
19R+ 80 1,92 202 4,848
38R+ 77 1,848 313 7,512
57R+ 73 1,752 425 10,2
38AR+ 72 1,728 221 5,304
53ARR+ 71 1,704 323 7,752
57AAR+ 71 1,704 221 5,304
54ARA+ 76 1,824 231 5,544
50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs.”
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2 Technical Specifications

2.1 General Specifications
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em M-Duino GPRS Family PLC
Power supply
voltage DC power supply 12 to 24Vdc
g ran DC power supply 11.4 to 25.4Vdc ===

voltage range

Power

consumption DC power supply 30W max.
Power supply Savde —
External power voltage
supply
Power supply 200mA

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external
AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

09 to 602C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-202 to 602C

Power supply holding time

2ms min.

Weight

Check size and weight table

2.2 Performance Specification

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz

17
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2.3 Symbology
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Table that includes all the symbology that is used in the serigraph of the M-Duino GPRS PLC

Family:

Symbol

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/
Graphical symbols
for use on
equipment

ISO 7000/
Graphical symbols
for use on
equipment

Standard
Reference No. /
Symbol Title

5031 / Direct
Current

5032 / Alternating
Current

5130 / Pulse
General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which
a pulse is started.

To identify an earth (ground)
terminal in cases where
neither the symbol 5018 nor
5019 is explicitly required.

To identify the switch by
means of which the signal
lamp(s) is (are) switched on or
off.

CE marking indicates that a
product complies with
applicable European Union
regulations

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

To indicate hazards arising
from dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino GPRS PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino GPRS Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in
this manual. Before using M-Duino under different conditions from what has been specified in
this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of M-Duino are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
double safety mechanisms. This manual provides information for programming and operating
the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

19



4 M-Duino Pinout
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10s Table
Analog Digital Isolated Digital Isolated Digital/Analog Relay PWM Isolated

Model Reference Input*’ Input Output Output Output output*?

19R+ 006001000100 4 1 0 3 8 3

21+ 006001000200 6 6 5 3 0 3
38AR+ 006001000700 10 6 5 6 8 6

38R+ 006001000300 8 1 0 6 16 6

42+ 006001000400 12 11 10 6 0 6
50RRA+ 006001000900 12 4 8 16 8
53ARR+ 006001001000 14 5 8 15 8
54ARA+ 006001001100 14 12 9 8 8 8
57AAR+ 006001000800 16 13 10 8 7 8

57R+ 006001000500 12 3 0 8 23 8

58+ 006001000600 16 17 14 8 0 8

*1The analog inputs can also be used as digital inputs.
*2The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM
and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base
A Zone
M-Duino Arduino Function
Connector Pin
AREF AREF Arduino Pin
sQw SQW Arduino Pin
3.3Vdc 3.3Vdc Arduino Pin
5Vdc 5Vdc -
GND GND GND
Base
A Zone
M-Duino Arduino Function
Connector Pin
SCL 21 12C/SS
SDA 20 12C/SS
RX0 0 RX0/SS
TXO0 1 TX0/SS
™ 16 RX2(serial 2
RX 17 TX2(serial 2
Z- - RS485
Y+ = RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51l 51 SPI
52 SCK 52 SPI
Reset Reset SPI
Vin5 Vin5 5V
GND - Gnd
GND - Gnd
24Vdc Power Supply

Rev. 6: 03-12-2024

Configuration Swilch® (see sechon 8 to
select the correct configuration for
outputs. Emabling communications diables
some Wilks)

Communication Pins

Power supply connectors [24Vde - GHND)
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any
device.

Ethernet Reset USB-B

RTC Programmable button

22



5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
1X.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)1X.6 GND IX.6
IX.6/INT? Interrupt X In**
(-)IX.5 GND IX.5
IX.5/INT? Interrupt X In**
(-)ix.4 GND IX.4
IX.4 Digital Input*
(-)1x.3 GND IX.3
IX.3 Digital Input
(-)IX.2 GND IX.2
IX.2 Digital Input
(-)Ix.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors 1X.12, 1X.11 and IX.4 are not connected (NC) in D

Zone.

**Connectors 1X.6 and IX.5 are not connected (NC) in C Zone and

connector IX.5 is not connected (NC) in B Zone.

2 See section 5.4 to know more about interrupt pins.

CLEANT 4
W AINT - ]
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Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isclated)
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Top Zone

xxxxxxxxxx

. = o P o @
xxxxxxxxxxx

Led indicator 1/Os state

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out
QVvdc External Isolated Out Vdc
COM(-) External Isolated Out GND
Qx.7 Digital/PWM Out*
QX.6 Digital/PWM Out
QXx.5 Digital/PWM Out
Qx.4 Digital Qut*
Qx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.o Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

5.3 Relay Zone connection (I/0s)

X Zone
M-Duino Function
Connector

RX.8 Relay Out

RX.7 Relay Out

RX.6 Relay Out

RX.5 Relay Out*

RX.4 Relay Out

AX.2 Analog Out*

AX.1 Analog Out

AX.0 Analog Out

GND GND

QXx.2 Digital/PWM Out*

Qx.1 Digital/PWM Out

QX.0 Digital/PWM Out
comM(-) External Isolated Out Gnd

Qvdc External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.

* Maole: wse comectly monfgueation for

ust this signal

[E R LIHE H
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Relay Outputs

Analog Oulpuls (Switeh
Configuration)

Digital Wi Outputs (isolated)

Configuraticn Switch®

{see section & to select the corect
configuration for outputs).

Analog Outputs

‘oltage Supply/Reference for

Digital/PWHM Outputs (isalated)

Digital Cutputs
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Top Zone
oo TN e R N A U O B e N o ¥ R
X X X X X X />< xX X
i» o Qé w ’ ; o ;; ] -
Led indicator I/Os state E
Relay Qutputs
X Zone Aniog
O 10%de
Diga.
M-Duino Connector Function '_':'m
Digral
RX.3 Relay Out R
RX.2 Relay Out s
E)ISII% REIC?KII(D)Ut £ b Analog/Digital Inputs
IX.5 Analog/Digital Input H 2
IX.4 Analog/Digital Input 'E ﬂ: o
:%g ﬁnalogfgigizai :npuz 2 i o Interrupt Inputs (isolated)
] nalog/Digital Inpu E _ v
IX.1/INT? Interrupt X In** 533
()Ix.1 GND IX.1 1=
DE?I{("\(‘)T Intergf\lpg rxlr(_lj*/** 55 3 Configuration Switch*
R i I g ] [see sechion 8 to select the correct

*Connector 1X.0 is not connected (NC) in B Zone.

. configuration for autputs).
**Connectors IX.1 and IX.0 are not connected (NC) in C Zone.

5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay
PLC R N
Zone PLC Input M-Duino Pin PLC Input | PLC Interrupt M-Duino Pin
Interrupt
0.6 INT1 PIN3 0.1 INT2 PIN3
B
C
2.5 INT3 PIN21 2.1 INT1 PIN21
D
2.6 INT2 PIN20 2.0 INTO PIN20

Check this link for more information.

3 See section 5.4 to know more about interrupt pins.
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Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino
Editor language:
Editor font size:
Interface scale:
Theme:
Show verbose output during:

Compiler warnings:

Display line numbers
Verify code after upload

Check for updates on startup

Use accessibility features

Additional Boards Manager URLs:

More preferences can be edited directly in the file

/home/annal.arduinolS/preferences.txt

(edit only when Arduing is not running)

Browse

English (English) v (requires restart of Arduino)
12
Automatic % (requires restart of Arduino)
Default theme v (requires restart of Arduino)
compilation upload
None v

Enable Code Folding

Use external editor

Save when verifying or uploading
fapps.industrialshields.com/main/arduina/boards/package_industrialshields_indexjson
OK  Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install

27


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

Rev. 6: 03-12-2024

6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch Help

Auto Format T
Archive Sketch
sketch_sep30,

void setup| FixEncoding & Reload

11 put ¥ manage Libraries.. Ctrl+Shift+]
} Serial Monitor Culvshiftrm
Serial Ploter CtrivshiftsL
void loop(
11 put y ly:

WIFI101 / WIFININA Firmware Updater

}
Board: "M-Duino GPRS family" B oards Manager..
Model: "M-Duino 19R+ GPRS" >
5 | Arduino AVR Boards >
Industrial shields boards > [REEN family
ndustrial Shields ESP32 > | Ardbox DALI family
Programmer: "Arduino as ISP* > Ardbex GPRS family
Burn Bootloader Ardbox WIFVET family

M-Duino family
-Duino DALI family
M-Duino GPRS family
N "
M-Duino WIFI/BT family

M-Duino WIFI/BT + GPRS family

Spartan family

Once it is selected M-Duino GPRS Family, an extra option will appear on Tools:
There, it can be selected the exact model for every family.

Aute Format Curl+T

Archive Sketch

sketch_sep30
void setup Fix Encoding & Reload

/1 put ¥ Manage Libraries.. Ctrl+Shift+
} Serial Monitor Ctrl+ShiftM
. Serial Plotter CtrlshiferL
void loop(
71 put Ly:
PUT Y| Wikt 01 /WiRNINA Firmuare Updater ¥
}
Board: "M-Duino GPRS family’ >

Model: "M-Duino 19R+ GPRS" > | © M-Duine 19R+ GPRS

> M-Duino 21+ GPRS
Get Board Info M-Duino 38AR+ GPRS
. I-Duino 38R+ GPRS
Programmer: “Arduino as ISP” >
M-Duino 42+ GPRS
Burn Bootloader
M-Duino S0RRA+ GPRS
IM-Duino 53ARR+ GPRS
IV-Duine S4ARA+ GPRS
M-Duino S7TAAR+ GPRS
M-Duino 57R+ GPRS

M-Duino 58+ GPRS

Also there are some examples of programming in File -> Examples -> Examples for M-Duino
GPRS family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.
https://github.com/Industrial-Shields/
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7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino GPRS Family uses B-USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino GPRS Family

- Select the correct M-Duino Board (M-Duino 19R+ GPRS in our example).

File Edit Sketch elp
Auto Format CrksT
Archive Sketch
sketch sep30)

void setup FXENcoding & Reload

/1 PUT Y Manage Libraries. Curleshifst
¥ Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L
void loop(|
11 PUE Y ikitor iR Firmure Updater ly:

}

Board: "M-Duino GPRS family"

Model: "M-Duino 19+ GPRS"

>

© M-Duino 19R+ GPRS.

M-Duino 21+ GPRS

GetBoard Info M-Duino 38AR+ GPRS

Programmer: "Arduino as ISP" >

M-Duino 42+ GPRS

Burn Bootloader
M-Duino SORRA* GPRS

M-Duine 53ARR+ GPRS
M-Duino S4ARA+ GPRS
M-Duino S7TAAR+ GPRS
M-Duino 57R+ GPRS

M-Duino 58+ GPRS

1

M-Duin iy, M-Duino 1 n o

- Select the correct port.

File Edit Sketch

Help

Auto Format ctr+T
Archive Sketch
oid setup() | Fix Encoding & Reload

sketch jul21a

/1 put yout Manage Libraries... Ctrl+Shift+
¥ Serial Monitor Ctrleshiftei
veid loop() { serial Plotter cerlvshiftel

/1 put your
} WIFi101 / WIFININA Firmware Updater

Board: "M-Duino family" >
Model: "M-Duino 58+" »

Port: "/dev/ttyACMO (Arduino Mega or Mega 2560)" >
Get Board Info fdewittyACMO (Arduino Mega or Mega 2560)

Programmer

Burn Bootloader
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8 How to connect PLC to power supply

- M-Duino GPRS Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSIBLE!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

B | ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- GND n-_l—ll "3“13'24 e }

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail: 4
-12vdc / 24vdc e ill

-2.5A R

-30W Sy
®.
L]
Industrial Shields power supplies provide parallel operation, overvoltage protection, and 8-
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.
iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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A Zone
Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
GPRS | - GPRS -
GPRS]| - GPRS -
Pin 3 | XX Pin 3 XX
GPRSRST | - GPRS RST -
SD| - SD -
FD | HD FD HD

OFF ON

SCL/I2.1

SDA/12.0
GPRS
GPRS

Pin3/10.1
GPRS RST

SD
FD RS485 HD

OFF ON

This is a Switch example from the M-Duino 57R+ GPRS. In this
case, SCL, SDA, 10.1, SD and HD are enabled. This means 12.1, 12.0,
Pin3 and FD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.
2. GPRS | - : Always at OFF position.

1. GPRS | - : Always at OFF position.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. GPRS RST | - : Always at OFF position.
2.SD | - : Always at OFF position.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone OFF ON
Switch OFF ON NC NC
NC : : NC NC
NC - - Q RTC
NC | RTC - RTC ~RTC
NC | RTC i RTC

This switch enables the communication with RTC using 12C. Having both switches in ON mode
activates the communication, whereas if they are in OFF mode 12C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - ]
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 Qx.6
AX.5 | QX.5 AX.5 Qx.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
Al7 Q1.7
Ale Ql.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qax.2
AX.1| QX.1 AX.1 ax.1
AX.0 | QX.0 AX.0 Qx.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF OnN We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0l Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin

SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RXO0 0
TXO0 1

RX (RS232) 17

TX (RS232) 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 I12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

In order to use them as an internal arduino direct PIN at 5V, it has to be considered that they
are pull-up inputs (a 2200Q) resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.3 SPI - MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.4Pin 3

To know how to configure this pin correctly, check section 9.

This pin is not established with a pull-up or a pull-down configuration. The state of the pin is
unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The
Arduino board allows the pin to be set in a pull-up configuration. If not it must be established
as an external pull-up or pull-down circuit in order to correctly work with this pin.
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11 A Zone Features: Communications § RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here* or here® to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here® or here’ to see more about this communication.

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
5
6 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195
7

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.
11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX/TX/Pin3 21/20/1/0/16/17/3

Check the switch configuration at section 9 to enable SS pins.

Click here® to see more about this communication.

11.5TTL

M-Duino has two TTL ports, RX0/TX0 and RX/TX. TTLO is accessed with the function Serial (pins
0 and 1 of the Arduino Mega) and TTL2 is accessed with the function Serial2 (pins 16 and 17 of
the Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).

Click here'® and here'! to see more about this communication.

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
K https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
10 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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11.7 GPRS & GSM
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The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC. Its

principal features are:

Quad-band 850/900/1800/1900MHz.

Work only with 2G technology.

Can send / receive SMS messages.

Can send / receive GPRS data (TCP/IP, HTTP, MQTT).

Commands).

Max. transmission speed: 85.6 Kbps.

SIM size: Micro SIM.

Serial transmission speed: 1200 bps up to 115200 bps (baud rate).

Controlled by AT Commands (3GPP TS 27.0077, 27.005 and SIMCOM enhanced AT

AT Command interface with transmission speed “automatic” detection.

When defining the pins in the program, take into account that the internal connections

between the SIM800L module and the Arduino Leonardo are the following:

Arduino Mega Pinout SIM800L Pinout
5Vvdc Vcc
GND GND
Rx1 (Pin 19) TxD
Tx1 (Pin 18) RxD
Pin 2 GPRS RESET

The GPRS / GSM protocol is always enabled as there are no switches that configure it. The

protocol uses the Serial 1 pins of the equipment to be able to communicate and the Pin 2 for

the module reset.

39



Rev. 6: 03-12-2024

11.8 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards package of Industrial Shields, there is a library that simplifies the RTC
implementation called RTC.

Click here® to see more about this feature.
11.9uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch isin ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here® to see more about this feature.

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.
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12 GPRS & GSM Programming Examples

12.1 How to use the GPRS Module

By following the steps on this blog™, you will learn how to work with the GPRS Module that is
inside the PLC. A brief explanation about the examples provided by the Industrial Shields
libraries from GPRS is done.

12.2 How to send SMS using GPRS from an M-Duino

Two blogs about how SMSs can be sent using GPRS have been written. The first one talks about
sending SMS when a temperature sensor reaches a certain threshold. You can find the blog
here®.

The second one is about general features of the GPRS module and describes an example from
Adafruit FONA libraries. Click this link® to go to the blog.

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-gprs-module-158
15

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-using-gprs-from-an
-mduino-403

16

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-by-using-plc-contro
ller-arduino-296
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

M-Duino GPRS | Another Industrial _.
Family PLC Shields PLC '

KRFC-6 Ferrite (4 Loop
™ ey 1Tx
IIELDED CABI
Ferrite KITA Férrite KITA

i X OXOXCAP) - ono
12/24v M 12124V

13.2 RS-485 Communication:

13.2.1 Half Duplex

M-Duino GPRS Another Industrial
Family PLC | Shields PLC
KRFC-6 Farrite (4 Loops)
RS485 5 3¢ T3 2h Reass
" HIE
Farrita KITA Ferrite KITA
GND ' GND
12/24v — ~ 12124V
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13.2.2 Full Duplex

M-Duino GPRS Another Industrial
Eamily PLC Shields PLC

KRFC-6 Ferrites (4 Loops)

RS-485

Ferrite KITA Farrite KITA

25000 EHooCss,

13.3 Ethernet

KRFC-6 Ferite
Ethernet

M-Duino GRPS Another Industrial

Ferrite KITA Ferrite KITA

12(-3223 XXX - E@ XXX %N?Uw

For Ethernet communication between Industrial Shields equipment an SFTP CAT-6 Ethernet
crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 4
Analog input 5.1
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15 I/0O technical details:

A comparison between the waveforms of the 1/0s from the M-Duino GPRS Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

2= BT 2dd . Bms o ——
u

DIGITALOUT

CHlz: S.@6U) | [Hm 5.6 M 208ms | CH1 t 286m

DIGITAL OUT

ARDUINOOUT

[LH— p=pgull] M 288us CH1 % 2B80m.)

PWM OUTPOUT

Tl

4

ARDUIND PWRM DUT

CH1 ¥ 26EEml
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

ARDUINODUT
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16 Typical Connections

GND N ()00
SM2124V o o J 0.0
SHIELDED CABLE

Ferrite KITA

= S— i e T

SHIELDED CAELE / Doursoad the MDUINO LAYOUT: \

Y

Ferrite KITA

= l 0 POWER
2204 B oomaw
SHIELDED CABLE ,J Duumbond oo MOURO LAYOUT:
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2024V a/c
GMND

Ferrite KIIA
224V B ocemAuANALOG W
- SHIELDED CABLE ~/  fexwewhaeeswen  \
' e U

Ferrite KITA
GND
cE )~
2r2av - DIMUTALANALOG IN
Dowrined e MOUNG LA YOUT:

SHIELDED CABLE
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010V
SHIELDED CABLE
@ 51224V %m—
GND
Ferrite KITA
GND {9
12124V

Ferrite KITA

0

ar

0.7
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SHIELDED CABLE

ALWAYS
CONNECTED
&
VOUT = Q/Vdc

SHIELDED CABLEf o wone tradata o \_
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Gﬂb{ﬁ

2124V

Ferrite KIT/

Ferrite KITA
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VOUT = Q/Vde

SHIELDED CABLE

L
I
SHIELDED GAEL? o v e E

* Sew the swilch
configutarion (ON)
f 512124V
k o A
J ALWAYS
JU1 CONNECTED
SHIELDED CABLE

VOUT = Q/ Vide
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A
ALWAYS
DNMNECTED
Ferrte KITA
— GND :[9] POWER VOUT = 0/ Vide
24 I DAGTALPWM OUT
Dowrioad B MOURMO LAYOUT:

SHIELDED CABL Fom

\VJ .
SHIELDED CABLE

a0

e

\ * Analog Outs no led /

Qe * See the switch
) configutarion (OFF}

o8
o4 GND KF
o0

SHIELDED CABLE
NC|) O o2
Ferrite KITA \[:/
GND

i
POWER
S. 224V ¥ ]? I awwwosour
SHIELDED CABLE)
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529"
connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x0.8 mm
Pin spacing 2.5mm

7 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

18
https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=CjOKCQjw_viWBhD8ARIsAH1mCd4jlzLvlJs5K_3|EpaW5Ango3FBLULTwiPFtyKaiP-rj4LSly6
7bWoaAuLnEALwW_wcB
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MCV 1,5/ 2-G-3,81 1803426% is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC® is the

male one. Both are from Phoenix Contact.

Article reference

MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm
Pin dimensions 0.8x0.8 mm

Article reference

MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=CjOKCQjw_viWBhD8ARISAH1mMCd763F0sGBmfjy5p

mZm9dKysA6ePciWt8md8utGsZX10fLpgsBx4mnoaAo9GEALwW_wcB

20

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=CjOK
CQjw_viWBhD8ARIsAH1ImCd6YjA37NgmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNslaAmgYE
Alw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807 & CMP=KNC-GES-

GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true
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18 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15

Top hot rail TH 35-15

154
155
-———] =004
15°
ROS
R12
RO8
o~
H
= —ed 1004
Sezione A / Section A R12
o~ 2,2 min. finoa / To 2,5 max
S| —e
1l
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisozn o JSTMDB38  MPo 68 Mechanical test Resistonce o torsil stess of yield ASTMDE3E P 68
Resishiwn o tazione o mttwo JTMDB3E  MPo 48 Tenslostength ASTMDE3E  WPa 48
Alongomento a rotvn JTMDB3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flaing modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 15016014 X/m'* 55
Termiche Temp di mmmolimento Vit mewdo B ASTM DISZS  °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 14
Tomperatu Ricot 1 B1 MRy KTHDe48  °C 7 Rebeating omperature 1.81 WPo ASTMDE4E  °C 7
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mould shrinkge ASTIDISE % 0405
Mk Flow Index 260°C - 98N KIMDIZ3E g0 111 Mkt Fow Indax 260°C - 98 ASTMDIZ38 g0’ 1.1
Comportamento Aubestinguerea (mm di spesor) s V-0(08) Flame test Self atinguisher (fhidkness in mm) [I[E2) V-0(08)
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondssien thiead 32 mm IECE9521  °C 90

Ialtronic si riserva il diitto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the moteriols without being obliged 1o forewarn.

Rev. 6: 03-12-2024

For optimal operation of the product, it must be located in an electrical cabinet with
IKO8 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes
0 29/08/2019 First implementation
1 02/03/2020 Second implementation
2 23/11/2020 Third implementation
3 30/09/2022 M-Duino GPRS Family User Manual Implementation
4 11/03/2024 Added section 14 “Digital inputs threshold detection”
5 26/09/2024 Added section 3.4 (“Isolation Precautions”)
6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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The M-Duino LoRa Family PLCs are Open Type Controllers. It is required that you install
the M-Duino LoRa PLC in a housing, cabinet, or electric control room. Entry to the
housing, cabinet, or electric control room should be limited to authorised personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when installing M-Duino
family PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des contrbéleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de Ia
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphéere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

o Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e QOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.

IS
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct manner. It
must respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS's test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED.

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
qb UL Std. 61010-2-201
c us Cert. To CSA Std. C22.2 No. 61010-1
e Cert. ToCSA Std. C22.2 No.61010-2-201
Intertek

Place for control
number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO LoRa product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and D the shield from above. Having a B and a C in the middle of them.:

HE EEE]
il i
gy Wwww
FZEEE ZEEZ
QRRR . RERQ
Lmo0O e D ZONR O @ <L
) ' C Z0NE
wwse B ZONE
(- r=miroi A ZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X

10
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Reference Table

Model Reference
PLC M-Duino General Family
M-DUINO PLC Arduino Ethernet & LoRa 19R I/Os Relay / Analog / Digital PLUS 015001000100
M-DUINO PLC Arduino Ethernet & LoRa 21 I/Os Analog/Digital PLUS 015001000200
M-DUINO PLC Arduino Ethernet & LoRa 38R |/Os Relay / Analog / Digital PLUS 015001000300
M-DUINO PLC Arduino Ethernet & LoRa 38AR I/Os Relay / Analog / Digital PLUS 015001000700
M-DUINO PLC Arduino Ethernet & LoRa 42 I/Os Analog/Digital PLUS 015001000400
M-DUINO PLC Arduino Ethernet & LoRa 50RRA I/Os Relay / Analog / Digital PLUS 015001000900
M-DUINO PLC Arduino Ethernet & LoRa 53ARR I/Os Relay / Analog / Digital PLUS 015001001000
M-DUINO PLC Arduino Ethernet & LoRa 54ARA 1/Os Relay / Analog / Digital PLUS 015001001100
M-DUINO PLC Arduino Ethernet & LoRa 57AAR I/Os Relay / Analog / Digital PLUS 015001000800
M-DUINO PLC Arduino Ethernet & LoRa 57R |/Os Relay / Analog / Digital PLUS 015001000500
M-DUINO PLC Arduino Ethernet & LoRa 58 I/Os Analog/Digital PLUS 015001000600

To find the reference of your M-Duino LoRa PLC, check the arrow in the picture below. In the

example, the reference is:

11
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Zones Table
Model Zone A Zone B Zone C Zone D

M-Duino LoRa PLC 19R+ v Relay - -

M-Duino LoRa PLC 21+ v Analog / Digital - -

M-Duino LoRa PLC 38R+ v Relay Relay -
M-Duino LoRa PLC 38AR+ v Analog / Digital Relay -

M-Duino LoRa PLC 42+ v Analog / Digital | Analog / Digital -
M-Duino LoRa PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino LoRa PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino LoRa PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino LoRa PLC 57AAR+ v Analog / Digital | Analog / Digital Relay

M-Duino LoRa PLC 57R+ v Relay Relay Relay

M-Duino LoRa PLC 58+ v Analog / Digital | Analog / Digital | Analog / Digital

The distribution of the different features that provide the M-Duino LoRa PLC Family is the

following one:

Shield B Zone C Zone D Zone
12 Inputs 13 Inputs 10 Inputs
(12 Digital Inputs, 6 (13 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
8 Outputs 8 Outputs 4 Outputs
(8 Digital Outputs, 3 | (8 Digital Outputs, 3 (4 Digital Outputs)
of which can work as | of which can work as
Analog Output) Analog Output)
5 inputs 6 inputs 6 inputs
(5 Digital Inputs, 4 of | (5 Digital Inputs, 4 of | (6 Digital Inputs, 4 of
which can work as which can work as which can work as
Analog Input) Analog Input) Analog Input)
Relay Shield
3 Outputs 3 Outputs 0 Outputs
(3 Digital Outputs, 3 | (3 Digital Outputs, 3
of which can work as | of which can work as 7 Relays
Analog Output) Analog Output)
8 Relays 8 Relays

12



1.4 A Zone Features
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Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(2x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) LoRa

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) | Depth (mm) | Max weight (g)
M-Duino LoRa PLC 19R+ 119.5 70.1 101 394
M-Duino LoRa PLC 21+ 119.5 70.1 101 394
M-Duino LoRa PLC 38R+ 119.5 94.7 101 504
M-Duino LoRa PLC 38AR+ 119.5 94.7 101 504
M-Duino LoRa PLC 42+ 119.5 94.7 101 504
M-Duino LoRa PLC 50RRA+ 119.5 119.3 101 614
M-Duino LoRa PLC 53ARR+ 119.5 119.3 101 614
M-Duino LoRa PLC 54ARA+ 119.5 119.3 101 614
M-Duino LoRa PLC 57AAR+ 119.5 119.3 101 614
M-Duino LoRa PLC 57R+ 119.5 119.3 101 614
M-Duino LoRa PLC 58+ 119.5 119.3 101 614

13
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CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information
Fuse protection (2.5A)
Input Voltage 12 to 24vdc Polarity protection
24 Vdc
Input rated voltage —
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB
N 12C — Ethernet Port — USB — RS485 — RS232 — SPI — (2x) Max232-Max485-W5500 -
Communications

RX, TX (Arduino pins)

Sim800L

USB consideration!

Only meant for uploading or debugging, not always
connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcc)

0to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 116 us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

All Digital Inputs are PNP .
Click here! for more information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vvcc)

5 to 24Vdc
I'min: 2 to 12mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc

I max: 20mA
Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70us delay,
freq is 6.849MHz
with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193

14
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA
Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin Do SLE .
I max: 40mA Max read time: 8us
InPUt Rated Voltage: 5Vdc
12C Pin Max frequency: 100kHz
5V Pull-up Rising edge time: 10us
Falling edge time: 150ns
Usable pins:
One-Wire Pin Pin3, SCL, SDA, RX0, TXO, Frequency: 800kHz
RX1, TX1, MISO, MOSI, SCK
Expandability 12C- 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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1.7 Power consumption of the M-Duino LoRa Family PLCs

Model Current resting | Power resting Current active Power active
(mA) (W) (mA) (W)

21+ 99 2,376 120 2,88
42+ 92 2,208 128 3,072
58+ 76 1,824 126 3,024
19R+ 80 1,92 202 4,848
38R+ 77 1,848 313 7,512
57R+ 73 1,752 425 10,2
38AR+ 72 1,728 221 5,304
53ARR+ 71 1,704 323 7,752
57AAR+ 71 1,704 221 5,304
54ARA+ 76 1,824 231 5,544
50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs.”

16




2 Technical Specifications

2.1 General Specifications
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M-Duino LoRa Family PLC

Item
Power supply
voltage DC power supply 12 to 24Vdc
Operating
voltage range DC power supply 11.4 to 25.4Vdc ===
power DC power suppl 30W max
consumption P pply .
Power supply 2avde —
External power voltage
supply
Power suppl'y 200mA
output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external
AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

02 to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-202 to 602C

Power supply holding time

2ms min.

Weight

Check size and weight table

2.2 Performance Specification

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePa

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz

17
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2.3 Symbology
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Table that includes all the symbology that is used in the serigraph of the M-Duino LoRa PLC

Family:

Symbol

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/
Graphical symbols
for use on
equipment

ISO 7000/
Graphical symbols
for use on
equipment

Standard
Reference No. /
Symbol Title

5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse
General

5017 / Earth,
Ground

5115/ Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which
a pulse is started.

To identify an earth (ground)
terminal in cases where
neither the symbol 5018 nor
5019 is explicitly required.

To identify the switch by
means of which the signal
lamp(s) is (are) switched on or
off.

CE marking indicates that a
product complies with
applicable European Union
regulations

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

To indicate hazards arising
from dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino LoRa PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino LoRa Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in
this manual. Before using M-Duino under different conditions from what has been specified in
this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of M-Duino are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
double safety mechanisms. This manual provides information for programming and operating
the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

19
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4 M-Duino Pinout
10s Table
Analog Digital Isolated | Digital Isolated Digital/Analog Relay PWM Isolated
Model Reference
Input*’ Input Output Output Output Outputs*?
19R+ 015001000100 4 1 0 3 8 3
21+ 015001000200 6 6 5 3 0 3
38AR+ 015001000300 10 7 5 6 8 6
38R+ 015001000300 8 3 0 6 16 6
42+ 015001000400 12 13 10 6 0 6
50RRA+ 015001000900 12 9 6 16 6
53ARR+ 015001001000 14 10 6 15 6
54ARA+ 015001001100 14 14 6 6
57AAR+ 015001000800 16 15 10 6 6
57R+ 015001000500 12 5 0 6 23 6
58+ 015001000600 16 19 14 6 0 6

*1 The analog inputs can also be used as digital inputs.

*2The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

M
O
Base
A Zone ] i
M-Duino Arduino Function 535 if'l’
Connector Pin - 1o
AREF AREF Arduino Pin )
sQw SQW Arduino Pin o
3.3Vdc 3.3Vdc Arduino Pin
5Vdc 5Vdc - i
GND GND GND Eg
f
i S | -
ok
ufe
1 L
Base E
A Zone
M-Duino Arduino Function
Connector Pin - —
SCL 21 12C/SS
SDA 20 12C/SS
RXO0 0 RX0/SS
TXO0 1 TX0/SS
RX1 19 RX1(serial 1
TX1 18 TX1(serial 1
X 16 RX2(serial 2
RX 17 TX2(serial 2
Z- - RS485
Y+ = RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51l 51 SPI ?_—é SSTCK §
52 SCK 52 SPI
Reset Reset SPI 5V
Vin5 Vin5 5V -
GND ] Gnd W;g
GND - Gnd i
24Vdc Power Supply

Rev. 6: 03-12-2024

Configuration Switch® (see section 8 1o
select the comrect canflguration for
outputs. Enabling commmunicatons diables
some 1),

Cammunication Pins

Power supply conneclors (24Ydc - GND)
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any
device.

Ethernet Reset USB-B

RTC Programmable button

22



5.2 Analog/Digital Zone connection (I/0s)

X Zone
M-Duino Function
Connector
IX.12 Analog/Digital In*
IX.11 Analog/Digital In*
IX.10 Analog/Digital In
IX.9 Analog/Digital In
IX.8 Analog/Digital In
IX.7 Analog/Digital In
(-)IX.6 GND IX.6
IX.6/INT? Interrupt X In
(-)IX.5 GND IX.5
IX.5/INT? Interrupt X In
(-)ix.4 GND IX.4*
IX.4 Digital Input*
(-)I1x.3 GND IX.3
IX.3 Digital Input
(-)1X.2 GND IX.2
IX.2 Digital Input
(-)IX.1 GND IX.1
IX.1 Digital Input
(-)1X.0 GND IX.0
IX.0 Digital Input

*Connectors 1X.12, IX.11 and IX.4 are not connected (NC) in D Zone

Top Zone

Led indicator 1/Os state

X Zone
M-Duino Function
Connector
GND GND
AX.7 Analog Out*
AX.6 Analog Out*
AX.5 Analog Out*
QVvdc External Isolated Out Vdc
COM(-) External Isolated Out GND
Qx.7 Digital/PWM Out*
QX.6 Digital/PWM Out*
QXx.5 Digital/PWM Out*
Qx.4 Digital Qut*
Qx.3 Digital Out
Qx.2 Digital Out
Qx.1 Digital Out
Qx.o0 Digital Out

*Connectors AX.7, AX.6, AX.5, QX.7, QX.6, QX.5 and QX.4 are not

% See section 5.4 to know more about interrupt pins.

N I

* Mole: use comectly mnfgueton for

us this signal

[E R LI H P
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Analog/Digital Inputs

Imterrupt Inputs (isolated)

Digital Inpuls (isalated)

Configuration Switch®

(see seclion B o select the correct
configuration for outputs).

Analog Ouiputs

Wollage Supply/Relerance far
Digital/PWM Qulpuls (isolated)

Digital Qutputs

connected (NC) in D Zone.
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5.3 Relay Zone connection (I/0s)
X Zone
M-Duino Function
Connector
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX.5 Relay Out*
RX.4 Relay Out
AX.2 Analog Out*
AX.1 Analog Out*
AX.0 Analog Out*
GND GND*
Qx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out*
Qx.0 Digital/PWM Out*
COM(-) External Isolated Out Gnd
Qvdc External Isolated Out Vdc

Rev. 6: 03-12-2024

Relay Outputs

Analog Outpuls ( Swilch
Configuralian)

Digiall PWM Oulpuls (Eokabed)

*Connectors RX.5, AX.2, AX.1, AX.0, GND, QX.2, QX.1, QX.0 and are not
connected (NC) in D Zone.

|
Top Zone g
(o] Ne} ~ od o (=] = o] =
X X X X X X X x X
E 3 = =
r o 5% £ e
N o — S o 9 o !
X X X X X x xX X

Led indicator 1/Os state - —

X Zone
=40
. . Relay O
M-Duino Connector Function ey Uiputs
RX.3 Relay Out ~d T
RX.2 Relay Out s,
RX.1 Relay Out Coggital
GND GND 5 - 24
IX.5 Analog/Digital Input .
IX.lsl Ana:og;Digita: Input e
IX. Analog/Digital Input ' - -
" Il);ﬁ\”s Anallog/Digita;g :nput i — I“;'l‘_':“ Analog/Digital Inputs
5 nterrupt X In £ (5]
(-)IX.1T4 GND IX.1 g :i"
IX(_(;I/)I(I\B Intéa'(lrg |c|>)t( )(() In ? IﬁE :E ) Interrupt Inputs (isolated)
-E = ()10
¥ § - ; .
: E.; .8 ;ﬁ Configuration Switch
| 3% E Eulamo (see section 8 1o select the comrect
!

— configuration for culputs).

3 See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table
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See the Reference Table in order to know the specific device details.

Analog/Digital Relay
PLC
Zone PLC Input Interrupt M-Duino Pin PLC Input | PLC Interrupt M-Duino Pin
8 0.6 INT1 PIN3 0.1 INT2 PIN3
1.6 INT4 PIN19 1.1 INT4 PIN19
¢ 1.5 INTS PIN18 1.0 INTS PIN18
2.5 INT3 PIN21 21 INT1 PIN21
° 2.6 INT2 PIN20 2.0 INTO PIN20

Check this link for more information.
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Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino
Editor language:
Editor font size:
Interface scale:
Theme:
Show verbose output during:

Compiler warnings:

Display line numbers
Verify code after upload

Check for updates on startup

Use accessibility features

Additional Boards Manager URLs:

More preferences can be edited directly in the file

/home/annal.arduinolS/preferences.txt

(edit only when Arduing is not running)

Browse

English (English) v (requires restart of Arduino)
12
Automatic % (requires restart of Arduino)
Default theme v (requires restart of Arduino)
compilation upload
None v

Enable Code Folding

Use external editor

Save when verifying or uploading
fapps.industrialshields.com/main/arduina/boards/package_industrialshields_indexjson
OK  Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch

Help

Auto Format T
Archive Sketch
sketch_oct053

void setup| FixEncoding & Reload

11 put ¥ manage Libraries.. Ctrl+Shift+]
} Serial Monitor Culvshiftrm
Serial Ploter CtrivshiftsL
void loop(
17 put ly:
PUE Y Wiki101 /WiRNINA Firmware Updater Y
}
Board: "M-Duino LoRa family” [ 50215 Manager...
Model: "M-Duino 19R+ LoRa™ >
, | Arduino AYR Boards >
Industrial Shields boards > R
ndustrial Shields ESP32 3 Ardbox DALI family
Programmer: "Arduino as ISP" > Ardbox GPRS family

Burn Bootloader Ardbox WIFI/BT family

Ardbox LoRa family
M-Duino family
M-Duino DALI family
M-Duino GPRS family
M-Duino WiFI/BT family

M-Duino WIFI/BT + GPRS family

Spartan family

Once it is selected M-Duino LoRa Family, an extra option will appear on Tools:
There, it can select the exact model for every family.

belp

Format CtrleT

Archive Sketch
sketch_oct054

void setup Fix Encoding & Reload

/1 put ¥ Manage Libraries.. Ctrl+Shift+
} Serial Manitor Crkeshifer

. Serial Ploter Ctrisshiftel
void loop(

Il put y Ly:

WIFI101 / WIFININA Firmware Updater

}

Board: "M-Duino LoRa family” >
Model: "M-Duino 19R+ LoRa" > | © M-Duino 19R+ LoRa
> M-Duine 21+ LoRa
Get Board Info M-Duine 38AR+ LoRa
X M-Duine 38R+ LoRa
Programmer; “Arduino as ISP >
M-Duin 42+ LoRa
Burn Bootloader
M-Duine SORRA+ LoRa
M-Duine 53ARR+ LoRa
M-DuinG 54ARA+ LoRa
M-Duine 57AAR+ LoRa
M-Duine 57R+ LoRa

M-Duine 58+ LoRa

Also there are some examples of programming in File -> Examples -> Examples for M-Duino
LoRa family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.
https://github.com/Industrial-Shields
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7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino LoRa Family uses B-USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino LoRa Family

- Select the correct M-Duino Board (M-Duino 19R+ LoRa in our example).

Void setup

11 put y
) Crisshitem
CulsshiftsL

void loop(

11 put y

WiFi101 / WIFININA Firmware Updater

O M-Duino 19R+ LoRa

M-Duino 21+ Loka
GetBoard Info

Programmer: *Arduino as ISP" >
M-Du

Burn Bootloader
M-Duino SORRA* LoRa

M-Duino S3ARR* LoRa
M-Duino S4ARA+ LoRa

M-Duino 57AAR+ LoRa

M-Duino LoRa femiy, M-Duino 19R- Lok on /dev/tiyACNO

- Select the correct port.

File Edit Sketch Help
Auto Format ctr+T
Archive Sketch
sketch jul21a
oid setup() | Fix Encoding & Reload

/1 put yout Manage Libraries... Ctrl+Shift+
¥ Serial Monitor Ctrleshiftei
veid loop() { serial Plotter cerlvshiftel

/1 put your
} WIFi101 / WIFININA Firmware Updater

Board: "M-Duino family" >
Model: "M-Duino 58+" »

Port: "/dev/ttyACMO (Arduino Mega or Mega 2560)" >

Get Board Info fdew/ttyACMDO {Arduino Mega or Mega 2560)

Programmer

Burn Bootloader
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8 How to connect PLC to power supply

- M-Duino LoRa Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSIBLE!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

B | ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- GND n-_l—ll "3“13'24 e }

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail: 4
-12vdc / 24vdc e ill

-2.5A R

-30W Sy
®.
L]
Industrial Shields power supplies provide parallel operation, overvoltage protection, and 8-
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.
iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone
Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
RX1 | XX RX1 XX
TX1 | XX X1 XX
Pin 3 | XX Pin 3 XX
LoRa | NC LoRa NC
SD | XX SD XX
FD | HD FD HD
OFF ON
SCL/12.6 This is an D Zone Switch example from M-Duino 58+ LoRa. In
SDA/12.5 this case, SCL, SDA, Pin 3, LoRa, SD and FD are enabled. This
Rx1/11.6 means 12.6, 12.5, 11.6, 11.5, 10.6, Q2.0 and HD are disabled.
Tx1/11.5
Pin3/10.6
LoRa / NC
SD/Q2.0
FD RS485 HD
OFF ON

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

2. RX1 | XX: Choosing between RX1 or the input XX. If the switch is ON, it enables XX and
disables RX1. If the switch is OFF, it enables RX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.
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1. TX1 | XX: Choosing between TX1 or the input XX. If the switch is ON, it enables XX and
disables TX1. If the switch is OFF, it enables TX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. LoRa | NC: Choosing between LoRa communication or NC. If the switch is ON, it disables
LoRa. If the switch is OFF, it enables LoRa.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

OFF ON

NC NC

A Zone NC NC

Switch OFF ON o RTC

NC - - “RTC

NC - -

NC | RTC - RTC
NC | RTC - RTC

This switch enables the communication with RTC using 12C. Having both switches in ON mode
activates the communication, whereas if they are in OFF mode 12C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - ]
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 Qx.6
AX.5 | QX.5 AX.5 Qx.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
Al7 Q1.7
Ale Ql.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, no connectors are connected (NC).
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qax.2
AX.1| QX.1 AX.1 ax.1
AX.0 | QX.0 AX.0 Qx.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF OnN We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0l Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, no connectors are connected (NC).
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10 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RXO0 0
TXO0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that
they are pull-up inputs (2200Q) resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.3 Serial 1 - RX1/TX1

To know how to configure these pins correctly, check section 9. If not using the Serial 1
interface these pins can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.4 SPI - MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,
they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.5Pin 3

To know how to configure this pin correctly, check section 9.

This pin is not established with a pull-up or a pull-down configuration. The state of the pin is
unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The
Arduino board allows the pin to be set in a pull-up configuration. If not, it must be established
as an external pull-up or pull-down circuit in order to correctly work with this pin.
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11 A Zone Features: Communications § RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here* or here® to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here® or here’ to see more about this communication.

https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
5
6 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195
7

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.
11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/Pin3 21/20/1/0/19/18/15/14/3

Check the switch configuration at section 9 to enable SS pins.

Click here® to see more about this communication.

11.5TTL

M-Duino has one TTL port, RX0/TX0. TTLO is accessed with the function Serial (pins 0 and 1 of
the Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).

Click here® and here® to see more about this communication.

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
K https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
10 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

Click here® to see more about this feature.
11.8uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch isin ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here® to see more about this feature.

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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12 Examples

12.1 What is LoRa and LoRaWAN?

For more information of the LoRa modulation, check this post™. In it you will find everything
you need to know about this communication.

To learn about the LoRaWAN protocol look at this other link™. A deep description and
explanation about the protocol is done in this blog

12.2 How to work with LoRaWAN and a PLC controller

If interested on working with LoRaWAN and a PLC controller this post'® may be helpful. In
addition, two examples are provided using the authentication methods OTAA or ABP. With
them, you will be able to communicate between the PLC and The Things Network.

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/what-is-lora-254

> https://www.industrialshields.com/blog/arduino-industrial-1/post/what-is-lorawan-253
16

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-work-with-lorawan-and-a-plc-
controller-255
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13 Instructions for interconnection between Industrial

Shields controllers
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13.3 Ethernet
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Another Industrial
Shields PLC

Feérrite KITA

~—~ GND
@/vmzw

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 4
Analog input 5.1
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15 I/0O technical details:

A comparison between the waveforms of the 1/0Os from the M-Duino LoRa Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

TR o —1
v

DIGITAL OUT

CHl= S.@au

DIGITALOUT
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

ARDUINODUT
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16 Typical Connections
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SHIELDED CABLE
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529"
connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8x0.8 mm
Pin spacing 2.5mm

7 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

18
https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=CjOKCQjw_viWBhD8ARIsAH1mCd4jlzLvlJs5K_3|EpaW5Ango3FBLULTwiPFtyKaiP-rj4LSly6
7bWoaAuLnEALwW_wcB
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MCV 1,5/ 2-G-3,81 1803426% is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC® is the

male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8 x0.8 mm
\\\
™S

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=CjOKCQjw_viWBhD8ARISAH1mMCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX10fLpgsBx4mnoaAo9GEALwW_wcB

20
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=CjOK
CQjw_viWBhD8ARISAH1MCd6YjA37NgmaaFBXgbRyGEXfAM8gDodVOWZPfYsLLQhnVygDn8ufNslaAmgYE
Alw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807 & CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true
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18 DIN Rail mounting

Profilato o cappello TH 35-7,5
Top hot roil TH 35-7,5

Profilafo o coppello TH 35-15

Top hot rail TH 35-15

154
155
-———] =004
15°
ROS
R12
RO8
o~
H
= —ed 1004
Sezione A / Section A R12
o~ 2,2 min. finoa / To 2,5 max
S| —e
1l
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS BLEND
DIMISURA PC/ABS METHOD PUABS
Mecconiche Resisozn o JSTMDB38  MPo 68 Mechanical test Resistonce o torsil stess of yield ASTMDE3E P 68
Resishiwn o tazione o mttwo JTMDB3E  MPo 48 Tenslostength ASTMDE3E  WPa 48
Alongomento a rotvn JTMDB3E % 5 Ui o ASTIDE3B % 5
Modulo in flesione JSTMDT0  MPo 26894 Flaing modults ASTDTI0 WP 2894
Prova lz0d con intoglio 5O1B0N4 W' 5 trod st notched 15016014 X/m'* 55
Termiche Temp di mmmolimento Vit mewdo B ASTM DISZS  °C 14 Thermal fest  Vieot sachering temprature method B ASTMDISES  °C 14
Tomperatu Ricot 1 B1 MRy KTHDe48  °C 7 Rebeating omperature 1.81 WPo ASTMDE4E  °C 7
Fisiche Peso gprifip SSTMD7T?  gdamd 121 Physicol test  Speciic gmuity ASTMDTS?  qu/and L2
Riti nello stompo JSTM DRSS 8% 0406 Mould shrinkge ASTIDISE % 0405
Mk Flow Index 260°C - 98N KIMDIZ3E g0 111 Mkt Fow Indax 260°C - 98 ASTMDIZ38 g0’ 1.1
Comportamento Aubestinguerea (mm di spesor) s V-0(08) Flame test Self atinguisher (fhidkness in mm) [I[E2) V-0(08)
alla fiommo Fib handesen. 37 mm EGE95.21  °C 90 Incondssien thiead 32 mm IECE9521  °C 90

Ialtronic si riserva il diitto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the moteriols without being obliged 1o forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with
IKO8 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes
0 27/08/2020 First implementation
1 01/12/2021 I/O’s serigraphy changed
2 04/10/2022 M-Duino LoRa Family User Manual Implementation
3 27/07/2023 Pinout count changed
4 11/03/2024 Added section 14 “Digital inputs threshold detection”
5 26/09/2024 Added section 3.4 (“Isolation Precautions”)
6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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